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 Welcome to FundRaiser Basic! 
 
FundRaiser Software is proud to introduce to you FundRaiser Basic, the 
“baby” of its fine family of donor management programs. Thank you for 
purchasing FundRaiser Basic -- we know it will help you and your 
organization improve your fundraising efforts. You’ll soon be doing more, in 
less time and with less effort, than you’ve imagined possible! 
 
Included in this package is this manual and the CD which contains the 
FundRaiser Basic software -- as well as copies of the other two FundRaiser 
programs: FundRaiser Select and FundRaiser Professional. You’re welcome to 
look at them . . . one of these days you may find yourself needing some of 
their more sophisticated features. You may want to read through this manual 
before installing FundRaiser Basic, to acquaint yourself with the features and 
overall layout. Or, you may prefer to install the program and then go through 
the manual, looking at the menus and screens as you go. Or, you may even 
skip the manual altogether, and just dive right into the program. Whichever 
method you choose, remember that there is online Help available to you, at 
every point in the program, at the click of your mouse. 
 
The first section of this manual covers installation of the program; the next is 
organized to follow the menus of the program, which will take you through 
each feature and function of FundRaiser Basic, explaining how to enter data 
into each field, and then how to use that data in composing and printing 
letters and reports. At the end of the manual is a glossary of terms that you 
may want to read through; and a section of Frequently Asked Questions you 
may find helpful. If you come across a discrepancy between how the 
program works and the information contained in this manual, it is probably 
because the program has changed slightly since this manual was printed. In 
that case, search in the Help files of the program, which are always current. 
 
If you have a question that isn’t answered in this manual or the online Help 
system, you can always email our Technical Support team at:  
support@FundRaiserSoftware.com. Giving our users the best support found 
anywhere is our goal; we want to help you succeed in your fundraising 
efforts.  
 
Okay, here we go . . . beginning a journey of discovery and learning . . . 
Enjoy! 
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 INSTALLATION 
The installation process is not difficult, and won’t take up too much time. We 
suggest you read through this section before you begin, to familiarize 
yourself with the process; then you can refer to specifics as you go.  First, 
there are a couple of subjects to go over. 
 
LICENSE AGREEMENT 
When you purchase FundRaiser Basic, we grant you a site license. This 
means that you may legally install FundRaiser on more than one computer 
so long as it is used only for your organization. We have many users who do 
some of their work at home, or who need to share data with another member 
of the organization. We’re happy for you to work this way, too.  In addition, 
you may share FundRaiser Basic with anyone you choose for evaluation 
purposes, but you may not share your registration code that unlocks the 
program. When they install the FundRaiser program on their computer, it will 
install itself in Evaluation Mode, which gives them an opportunity to try out 
the program. It is your responsibility to determine if the program will work 
reliably on your equipment and for your particular business environment. 
That’s why a money-back guarantee and evaluation copies are made 
available to you. 
 
FundRaiser Software / Edgewalker Enterprises (FRS/EE) disclaims all  
warranties relating to this software, whether express or implied, including but 
not limited to any implied warranties of merchantability and fitness for a 
particular purpose, and all such warranties are expressly and specifically 
disclaimed. Neither FRS/EE nor anyone else who has been involved in the 
creation, production, or delivery of this software shall be liable for any 
indirect, consequential, or incidental damages arising out of the use or 
inability to use such software even if FRS/EE has been advised of the 
possibility of such damages or claims. In no event shall FRS/EE’s liability for 
any damages ever exceed the price paid for the license to use the software, 
regardless of the form of claim. The person using the software bears all risks 
as to the quality and performance of the software. 
 
This agreement shall be governed by the laws of the State of Missouri and 
shall inure to the benefit of FRS/EE and any successors, administrators, heirs 
and assigns. Any action or proceeding brought by either party against the 
other arising out of or related to this agreement shall be brought only in a 
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 state or federal court of competent jurisdiction located in Howell County, 
Missouri. The parties hereby consent to in personam jurisdiction of said 
courts. 
 
SUPPORT AND UPDATE POLICY: 
Of course you can contact us for help! We provide support whether you’re 
still evaluating FundRaiser or have purchased it. If what you need isn’t in this 
manual, or in the Help system that’s built into FundRaiser Basic, you can look 
on our website, where there’s lots of information, or you can e-mail our super 
Tech Support team. 
 
Here is how you can reach us: 
Email: support@FundRaiserSoftware.com 
Web Page: http://www.FundRaiserBasic.com 
 
Our business hours are from 9am to 5pm Central Time, Monday through  
Friday. We are closed on all federal holidays and on a few other occasions 
for brief vacations during the year. 
 
Our experience is that most FundRaiser Basic users don’t need us for tech 
support -- FundRaiser Basic really is that easy to learn and use. If you do run 
across a problem that’s not covered in the Help files or this manual, don’t 
hesitate to email us. We’re interested in you and your organization’s 
fundraising success, and will help in whatever ways we can. 
 
UPDATES:  
Minor updates to FundRaiser Basic are FREE. You'll be able to download and 
install the minor updates from our website for as long as you continue to use 
the product. 
 
Occasionally, we release upgrades which include new features. These  
upgrades are available for a small fee. When an upgrade (rather than an  
update) is released, you must purchase the upgrade in order to be able to 
continue installing free updates that are released after this. 
 
The best way to hear about all updates (and other FundRaiser news and  
usage tips) is to send us your email address, and update it with us, if it 
changes. Don’t worry, we don’t sell our list and only use the address to send 
you newsletters and occasional other information about FundRaiser. 
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 Okay, now we can get to the actual installation of FundRaiser Basic . . . 
 

INSTALLATION: 
 
Installing FundRaiser Basic from a CD is easy. Just follow these steps: 
1. Put the CD in your CD drive and close the door. Wait for the FundRaiser 
Family program to load. 
2. Click on the “Install Software” tab. 
3. Click on FundRaiser Basic. 
4. Click on the INSTALL button. This will start the Setup program for FundRaiser 
Basic. 
 
NOTE:  You can Skip the above steps and just download the latest version 
from our website, www.FundRaiserBasic.com and Save the setup program to 
your computer.  After download is complete, run the setup program from 
where you saved it to begin installation. 
 
5. The first window in the Setup program is the Welcome window. Click NEXT. 
6. Select Destination Location. This is really the only step where you might 
want to make a change, and it depends on whether your computer is on a 
network or not. If in doubt, leave the default unchanged as: 
C:\FundRaiser\FRBasic . If your situation calls for you to change the default 
location, click on the Browse button to pop-up a standard “select destination 
directory” window. 

• First, choose the desired drive from the dropdown list at the bottom of 
the window. 

• Next, find the folder into which you want to install FundRaiser Basic.    
Sometimes it is necessary to first click on the top-most folder in the list    
(labeled something like C:\ or F:\ ) before you will find that folder. 

• When the top edit-box of this window contains the full and proper    
location path, click OK. --- For example, if you are installing 
FundRaiser Basic onto a server computer of your network, it might 
read: \\{servername}\FundRaiser\FRBasic. 

• When you have the Destination Folder properly set, click NEXT. 
7. Your choice in the “Select Program Manager Group” window determines 
where in the Start Menu FundRaiser will be located. Normally, you should 
accept the default: FundRaiser. Click NEXT. 
8. The next window simply gives you the opportunity to go back to a previous 
window and make any changes before the installation of all the files begins. 
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 When you’re happy with the way everything is set, click NEXT. 
 
9. You will see all the program and data files listed as they are installed. 
When it stops, click on the FINISH button. 
 
10. Take the CD out of the computer, or if downloaded, move the setup file to 
the Destination Directory specified during installation to store it for 
safekeeping. (If, for instance, you buy a new computer, you’ll need the CD to 
re-install the program, so do keep it safe. The Downloaded setup file will be 
saved to when you backup your data if included in the Destination Directory) 
 

Setting up FundRaiser Basic With Two (or More) Separate Sets of Data 
 
If you want to keep your media contacts separate from your donors/
prospects, or if you are doing volunteer work for multiple organizations, then 
you may want to be working with two or more separate copies of FundRaiser 
Basic. -- Please be aware that all copies of FundRaiser on the same 
computer will bear the same registration name (which will appear on all 
report headings).  
 
Here’s how to set up separate sets of data: 
 
1)Install FundRaiser Basic once for each set of data.  For the first installation, 
you can accept the default folder (directory) name of 
C:\FundRaiser\FRBasic, but during each subsequent installation, you will 
need to specify a different folder name (click on Browse when it asks during 
installation and type in a new folder name). 
 

a) Right-click on the icon saved to the desktop to pop up the menu. 
b) Click on Rename. 
c) Enter the name that you want to appear below the icon and press 
Enter. 

 
2) After the second installation, and each time you install FundRaiser, it will  
create a new icon for you if you rename the previous shortcut as described 
above. Windows will simply change the location associated with the 
previously installed icon if you leave the name the same. But, you can fix the 
shortcut and create a new one for each installation by doing the following: 
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 a) Right-click on the FundRaiser icon to pop up a menu. 
b) Click on Create Shortcut. 
c) Right-click on the newly created icon-copy to pop up a menu. 
d) Click on Properties. 
e) Click on the Shortcut tab. 
f) Change the folder name in Target and Start in to the correct folder. 
g) Click OK. 
h) Right-click again on the icon-copy to pop up the menu. 
i) Click on Rename. 
j) Enter the name that you want to appear below the icon and press 
Enter.  Important Note: Whenever you install an update to FundRaiser 
Basic, you will need to update all folders by running the setup file for 
each instance of the program, and you should check the folder names 
in Properties as described above to make sure that Windows did not 
change them. 
 

Now, to Run FundRaiser Basic: 
 
Click on the FundRaiser Basic icon that was placed on your desktop during 
the installation process.  Next, there are a few tasks that you need to do 
before you start entering data . . . . 
 
Enter Your Registration Code.  The letter/receipt you receive from us in the 
FundRaiser Basic package contains your Registration Code; or you may 
receive the code over the phone or by email.  
 
To enter it: click on Enter Registration Code in the Help menu, which will bring 
up the Registration window.  
 
First, enter your Registration Name. This is the name that will appear at the 
top of reports and in the copyright window. If you have received your 
Permanent code, you must enter the name exactly as it appears in the letter 
alongside your code. The code is generated from that name, and must 
match it exactly. If the name as it appears in the letter is not what you want 
to appear on reports, contact us for a new code before you enter a code for 
the incorrect name. 
 
Second, enter the ten-character Registration Code. 
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 Third, select either Permanent or Temporary. If you are not sure which type 
you have, try one.  If it fails, try the other. You are given a total of three tries 
before the program terminates. If that happens, don’t worry. Just start 
FundRaiser up again, and re-enter the codes. 
 
What if you can’t get the code to work? If it’s a Temporary one, then it has 
probably expired, and you need to get a new one from us -- send us an 
email. If it’s a Permanent code, then check that you entered the Registration 
Name exactly as it’s written in the letter we sent you. (Check UPPER/lower 
case, punctuation, spelling.) If you can see no difference, ask someone else 
to check it. If neither of you can see a difference, email us at  
Support@FundRaiserSoftware.com 
 
Looking Around: 
Now is a good time to explore the program, before you enter “real” data. 
Enter some play data, print a letter or report, peer into all the corners of the 
program. 
 
Next Step: 
Before we import data from FundRaiser Basic-DOS, or another program, let’s 
set up FundRaiser to work just the way you want it to. Turn to page 54 and 
work through setting up General Preferences and Name Defaults in the 
Options Menu. Then come back here, and we’ll go on . . . 
 
Delete the Sample Record 
You may have noticed that FundRaiser creates a sample donor record when 
you first start up the program. (The donor name is Louisa May Alcott, if you 
need to find it.) Delete this record, and any “play” records you may have 
created by clicking on the Delete button. 
 
Importing Data from FundRaiser Basic 
Bringing in the data from a previous version of FundRaiser Basic is easy. Click 
on File|Import, and then choose FundRaiser Basic to import. If you need help 
with this, complete instructions are in the Help files. 
 
Importing Data from Other Programs 
If your data is in a non-FundRaiser program, then you must first go to that 
program and Save As or Export the file in one of three common data formats: 
comma-delimited ASCII Text (CSV), tab-delimited ASCII Text, or dBase III 
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 (DBF). Then return to FundRaiser Basic, review the ‘Importing from ASCII’ 
section on page 16, and start the process. Be sure to let FundRaiser make a 
backup of your data (which it will offer to do in the middle of the process). 
 
Run “Recalculate Giving Totals” 
It is a recommended practice to run File|Recalculate Giving Totals. This will 
build the Contribution sub-totals and other information displayed in the 
Details page of the Donor Screen. 
 

Okay, that’s it! You’ve installed FundRaiser Basic, tailored it to work the way 
you want it to, and brought in old data. Now, just a few tips, and then we’ll 
turn you loose! 
 
USING THE HELP SYSTEM 
 

FundRaiser Basic’s Help system is quite complete -- you’ll find answers and 
explanations for just about everything there. And it’s easy to use. Those of 
you who are familiar with Windows will already know how to use the Help 
system; for those who aren’t, let’s review: 
 

You can access Help from within FundRaiser by any of several methods: 
• clicking on the Help menu at the top of the window. 
• clicking on any Help button, 
 pressing the “F1” key on your keyboard; 

or from outside FundRaiser by clicking on Start, Programs, FundRaiser, Help 
for FundRaiser Basic . 
 
Once you’re in the Help system, there are three ways to use it: 
 

• click on the Contents tab to go to the Table of Contents page. Then 
click on any topic that is of interest to you. 

•  click on the Search Tab to find any word or phrase within the Help 
Files. 

• click on the Index tab, which will take you to a window with an edit 
box into which you may type a word or phrase about which you 
want information. 

 

As you type, the scrolling list will highlight topics; when you find the one you 
want, click on the Display button. One of the headings in the Contents 
section of Help is “Common Tasks”. This section helps you learn how to do 
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 the tasks FundRaiser is so good at; and this is a good place to start learning 
how to use FundRaiser Basic. And now a few tips on how to help FundRaiser 
run smoothly: 
 

Important “Housekeeping” Tips 
Getting into the right habits at the beginning is always a good idea. Using 
FundRaiser Basic properly requires that you perform a few “housekeeping” 
chores on a regular basis.  
 

Backups 
 

Making backups is very important. At some point (or points) in your 
relationship with computers, these helpful, time-saving, infernal machines will 
fail you. Your data is important (no ‘if’ there!), we recommend making 
regular backups! Ideally, a backup is made daily. If that’s too inconvenient 
for you, plan backups weekly or so; whatever will work into your schedule.  
 

It’s easy to make backups in FundRaiser Basic:  click on the File menu, on 
Create Backup, and then on the Backup button. You can backup to a Net-
work location, USB Thumb/Flash drive, a diskette, a zip or jazz drive, or even 
a CD/DVD.  If you intend backing up to a CD/DVD, however, be aware that it 
must be pre-formatted to accept data files, using your CD/DVD recording 
software, or Windows dialogs. 
 
You can also us any one of several “external methods to copy your Fund-
Raiser Basic data.  Please click on Help button to see specific directions. 
 
File Maintenance 
Running File Maintenance on a regular basis is a must. It should be run at 
least monthly; weekly is much better. Find it under the File menu. -- This does 
two things: it erases donors and gifts which you have marked for deletion; 
second (and more importantly), it rebuilds data files and index files -- this is 
critical to the smooth operation of FundRaiser Basic.   
 
Help with Fundraising 
Visit our website, www.FundRaiserBasic.com , and click on the ‘Library’ page;   
you’ll find FundRaiser University, with articles on using FundRaiser Basic for 
donor management and fundraising, and other resources to learn more.  You 
can also sign up to receive the electronic FundRaiser Basic newsletter by 
email. 
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 Okay, you’re about as ready to get into FundRaiser Basic and start working 
as you’ll ever be!  So go to it, have fun, and remember that we’re available if 
you need us . . . 
 
In the Donor Screen you’ll see two tool bars, one horizontally across the top, 
and one vertically down the left side. Briefly, here are what these buttons will 
do, and where to find more detailed information on these tasks. 

Navigation   Enables you to move through your donor list, one record at a time,  
  and lets you change the order in which the records are displayed. 
Search   Lets you search for a particular donor by name, or other field. 
Search Again   Lets you repeat your search. 
Queue  Lets you build a list of donors one by one, for which you may print  
 letters, labels, or envelopes.   
Query  This brings up a window where you enter criteria to select a group  
 of donors from your list, for viewing, printing, or exporting.   
Word Processor  Click here to call up FundRaiser’s word processor.   
Exit  Click here to exit FundRaiser Basic. 
 

 
Add Click here to Add a new donor or prospect.   
Delete  Click here to mark a donor record for deletion.   
Save  This button is enabled once you have added a new  
  donor, or made a Change to an existing donor record. 
  Click here when your entry or change is complete. 
Cancel  Click here to cancel any Add or Change, without saving. 
Reminders Click one of these ten buttons to record a reminder 
  or note to yourself (these are not tied to any particular 
  donor).  When you do so, the icon will change to display a  
  Blue “i” on the Post it.  
When you click on a Reminder button, a window appears with a text  
area and three buttons: 

Delete Button: click here to delete all text from the Edit window. 
Print Button: click here to print this reminder. 
Close Button: click here to close this window and save any text. 
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 Navigation Control 

| First | Previous | Change Order | Next | Last | 
 
Clicking on this control enables you to move through the donor list one 
record at a time. These movement commands are also accessible from the 
GoTo Menu. Clicking on the center button enables you to change the order 
in which the donor records are arranged and displayed, both in this screen 
and when printed. If the current donor record is deleted, Deleted will appear 
in red on this center button (instead of “current order”). 
 

Queue Window 
 
 
 
 
 
 
 

You can print letters, labels, and envelopes for donors in this queue list. The 
basic idea is to find the donors you want to print for, then click on the Queue 
Button and then on the Queue Window’s Add Donor button. Once you have 
your Queue built, click on the Print Menu, then on letters, labels, or envelopes 
to print. In those windows, select “Donors in Queue List”. 
 

Example: You have a list of people who have asked for information about 
your organization. Of course you have added them into FundRaiser - they’re 
hot prospects. Anyway, you may want to print labels for each of these 
people to affix to a letter or brochure that you want to mail to them. The 
simplest way to do so is to simply add each one to the Queue list as you Add 
them.  
 

Add Donor   Click on this button to add the donor currently displayed  
   in the main window to the Queue list. 
Delete   Select a donor in the Queue list, then click this button to  
   delete them from thelist. 
GoTo    Select a donor in the Queue list, then click this button to  
   display the donor’s record in the main window. 
Close   Close this window and return to the Donor Screen. 
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 How is the Queue different from a Query? 
The Queue is used when there is no pattern to those you want to group 
together. You are picking and choosing, for whatever reason, each donor to 
add to the Queue.  
 
In a Query you select people based on some pattern, like all who have the 
same Category code, or who gave during a specific time period. 
 
File Menu 

Browse Pops up a spreadsheet-style column and row listing of all  
the donors. Within this Browse window, you can search 
fora donor, change the order in which they are displayed,  
and edit most of the data directly. 

 
Import The import section enables you to import from FundRaiser  

Basic. You can also import ASCII text files and dBase files 
from any other program. 

 
Export This section enables you to copy your FundRaiser data to  

file(s) which you can import into other programs or send to 
 other people or service bureaus. 
 
Create Backup This is where you go to make a backup of your data to  

disc. 
 
Restore Backup You use this feature when you want to totally replace your 
 data with the data that is on your backup disc. 
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 File Maintenance This section erases records that have been marked for  
   deletion, and rebuilds the index files. We suggest you do  
   this at least once a month; once a week is much better. 
 
Check Data Integrity When computers “hiccup”, data can become  
    corrupted. This menu choice will help to identify 
    and fix data corruption problems. 
 
Recalculate Giving Totals This section recalculates the giving totals that 
     are displayed on the Details Tab in the main 
     Donors Screen. 
 
Recreate Code Dropdown Lists  This utility will repopulate the dropdown 
       lists from the data in your lists. 
 
File Details  This displays the names of the database files   
   currently in use, their location, and the number of  
   records in each. 
 
Exit closes the FundRaiser program, and closes all data files. 
 
Browse Window 
The Browse Window lets you view more than two dozen donor records at 
once in a convenient spreadsheet-style format. This is especially helpful if 
you want to be able to quickly browse through your records, just as though 
you were thumbing through paper index cards. 
 
Changing and Moving Columns 
Sometimes you will want the columns arranged differently than the default. 
For example, you may want the city and state columns positioned to the 
right of the donor’s last name. And you may want to narrow the last name 
column, too.  
 
To resize a column (make it narrower or wider) position the cursor on the right 
edge. The cursor will change to a two-headed arrow. Click and drag that 
edge to the left or right as desired. 
 
To move a column, click on the column heading and drag it to the desired 
position. When you click on the column heading, you will see the left edge of 
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 the column turn bold. As you drag it, it will move, showing where its position 
will be if you release the mouse button. 
 
To move a column to a position that is off the screen, it is best to drag the 
cursor to the arrow buttons on the left or right ends of the horizontal scroll bar. 
 
Sort Order 
To change the order in which the records are displayed, click on the 
appropriate radio button. The records will immediately shift to the new order, 
with the currently selected record remaining in its original position. 
 
Search 
This window uses the same Search function as found in the main Donor 
Screen. 
 
Import 
 
Import From FundRaiser Basic 
This option is especially useful if you are swapping lists with another user of 
FundRaiser Basic, or if a volunteer is entering names for you from a printed list 
into a personal copy of FundRaiser Basic. (It’s fine for you to make copies of 
FundRaiser Basic for volunteers to use in this way.) To prepare the data, see 
the Note at the end of this Import section, under “Restore Backup” at the 
bottom of page 20.   When your data is ready to import, the procedure is 
quite simple. 
 
First, click on File, then Import, then FundRaiser Basic. Now, simply select the 
folder in which the copy of FundRaiser Basic can be found. Then click on the 
Import button. That’s all there is to it. 
 
Import From ASCII-DBF 
These two industry standard database formats enable you to import data 
from a variety of other database programs. If you own one of the currently 
popular database managers like Access or Paradox, you will be able to 
Save As or to Export in one or both of these formats. If you are able to export 
in both ASCII and dBase, we suggest you choose the dBase III format as it will 
simplify the process somewhat. Importing from a non-FundRaiser database 
can be complicated and confusing. With our Import Wizard, we’ve 
attempted to make it as easy for the technically-challenged as it is flexible 
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 for the database-techie. We’ve also anticipated common mistakes and will 
do things like filling in missing name fields from other name fields and 
determine donor type from address patterns. Just the same, we will certainly 
understand if you get confused and need our help in this area; feel free to 
contact us for assistance. 
 
Step 1: Select Import File. Click on the Browse button to select the file to be 
imported. If importing a dBase file, select the file with the DBF file extension 
(not the DBT file, if there is one). One of the most confusing parts of importing 
(lost files) occurs right here. Often, when Exporting or Saving As in a 
database manager program, you will specify only the name of the file. You 
don’t notice which directory (or folder) that the database program places 
your file into. If you don’t know which directory your file is in, go back to your 
database program and look at the dialog window in which you named your 
Saved As or Exported file. It will show the default name of the directory 
someplace in that dialog window. Then come back here and navigate to 
that directory in the Browse button’s dialog window. 
 
Step 2: File Determination Window. First, FundRaiser tells you what type of file 
this is. The choices are dBase, Comma Separated Values (comma 
delimited), and Tab Delimited. If FundRaiser cannot determine what type of 
file you’ve selected, it will tell you so here. In that case, try going back to 
your database manager and Saving As or Exporting in another file type.   
 
If this is an ASCII file (comma delimited or tab delimited) there will be these 
additional sections: 
In the center text area, FundRaiser will report if it found any errors in your file. 
If it finds any, it will not import those. You should attempt to fix those lines in a 
word processor. 
 
Important: be sure to save the file as an ASCII text file or DOS text file. 
FundRaiser will ask if the first line contains field names. Take a look at the 
display and check the box if the first line does contain fieldnames instead of 
real data. If it does,  FundRaiser will use those instead of generic field names 
(like Field1, Field2, etc) in the field matchup window and will not import it as 
real data. 
 
Step 3: Backup. It is usually a good idea to make a backup copy of your 
FundRaiser data before importing a new file into it. If you select Yes, it will 
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 copy your data files into a Backup directory directly under the FundRaiser 
Basic directory. After importing, if you decide that the import was a mess (did 
not import as you expected), then you can copy those files back using the 
“Restore Backup Files” choice in the File Menu. 
 
Step 4: Field Matchup. In this window, you match up the fields from your file 
with the fields in the FundRaiser file. 
 
First, click on one of your fields that you want to import into FundRaiser. Then 
click on the field in FundRaiser that you want to import it into. Then click on 
the >>> button to add the matchup to the Imported Data list. If you make a 
mistake, select the matchup in the Imported Data list, and click on the <<< 
button. 
Important: You can import more than one field into a FundRaiser field. The 
first field is imported, then a space is added, then the second field. In the 
case of Notes, each imported field goes on a separate line. 
 
View Data Buttons. Click on these buttons to view your data or FundRaiser’s 
data. Please note that you can move the column borders by clicking and 
dragging so that you can see more than one imported column at a time. 
 
Rename Field Button. This is especially useful if your fields have no names 
and FundRaiser assigned generic names (Field1, Field2, etc). Select the field 
to be renamed, then click on this button. 
 
What if FundRaiser doesn’t have a place to put a field? Import it into Notes. 
 
What if a FundRaiser field has two equivalent fields in your database? Zip 
code is a good example, which is recorded in two separate fields in some 
databases (the first 5 digits in one field, the last 4 in another). In this case, first 
import the first field into the FundRaiser field, then import the second field into 
the same FundRaiser field. FundRaiser will combine the two when it imports. 
Another good example is the name. Some databases have a separate field 
for each component of the name, like title, first, middle, last, suffix. You 
should merge just first (or maybe first + middle) into first, and last (or last + 
suffix) into last. Then merge all the fields, one after the other, into the 
Mailname field. 
 
FundRaiser has three forms of the name and I have only one. No problem. 
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 Import your one field into MailName. FundRaiser will break it into its 
constituent parts for the First and Last fields. By the way, if you neglect to 
import anything into MailName, FundRaiser will create it by combining the 
First and Last fields. 
 
Step 5: Import Options.  Convert Name and Address to Proper Case If your list 
is in all UPPER CASE, then you should have FundRasier convert your names 
and addresses to Proper Case for you. It does a pretty good job of it. 
 
Break Out State and Postal Code from City Field.  If your database has all 
three pieces of information recorded in one field, like City, ST 11111, don’t 
fret. Just import it into the City field and check this option. FundRaiser will 
break it out into 3 separate fields for you. 
 
Fill in Missing Area Code. If you have been recording your phone number 
without area codes (because all your donors live in the same area code), let 
FundRaiser assign the same area code to all phone numbers. When you 
check this box, FundRaiser will give you a space in which to enter the default 
area code. 
 
Fill the Salutation Field.   It is rare for an imported database to have a 
separate salutation field, so FundRaiser will attempt to fill it in for you. The first 
choice (first name or title + last) is what you should check if you want to use 
the first name of the donor in the Salutation. If FundRaiser Basic cannot find a 
first name, it will use title and last name. The second choice should be 
checked if you never want to use the first name, and do want to use a more 
formal title+last name Salutation. If you do not want FundRaiser to do 
anything with this field, or if you are already importing into it, then check the 
last choice. 
 
Final Step: When you click on the Finish button, FundRaiser will immediately 
begin importing. When it is done, we suggest you switch the current order to 
Account order and then navigate to the last record added. Then either 
Browse the list or navigate through it in the main Donor Screen to see how the 
data looks. If it did not import properly and you want to try again, you can 
restore your backed up data (you did check that option, didn’t you?) before 
trying again. 
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 Create Backup 
This menu choice places a copy of your FundRaiser data for safekeeping, or 
for transfer to another computer. The three data files that it copies are: 
MASTER.DBF, MASTER.DBT, and GIFTS.DBF . It also copies your configuration 
file, FRBWIN.INI, and all of your form letters (those with an RTF extension).  The 
default is for the backup to be made to your My Documents folder. If you 
want the backup to be placed elsewhere (like onto a Zip drive, or to your 
network), click on the Browse button to select the destination disk drive and/
or folder name. 
 
NOTE: If your data files are too big to fit on one disc, then FundRaiser Basic 
will not be able to create your backup. In this case, you will need to backup 
to a larger disk (like a Zip drive), or use another backup system (like the one 
built into Windows) which can accomodate large files. Alternatively, you can 
use the Windows Explorer to copy first one file (MASTER.DBF) onto one disk, 
and then the other two files (MASTER.DBT and GIFTS.DBF) onto another disk (or 
two).  
To restore the backups made with these other programs, you will need to use 
the same program that you used to create the backup. 
 
Restore Backup 
Use this File Menu choice to replace the FundRaiser data on your computer 
with the data that is on a backup location.  
 
** Important note: this does not add the backup records to your current list -- 
it replaces your existing list with the list that is on the backup location! ** 
 
This feature is typically used in two circumstances: 1) after a hard disk crash 
or computer failure; or 2) to update a new computer, or home computer with 
work done at the office (or vice versa). In both cases, you must have created 
the backup using FundRaiser Basic’s Create Backup feature. In most cases, 
you will restore from a removable media. If you need to restore from another 
location, click on the Browse button to select the disk drive and/or folder 
name where your backup is located. 
 
Export 
Export puts a copy of your data in a separate file. You can be selective 
about what data is to be included, and (by first setting a Query) can be 
selective about which donors will be included. 
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 Use the Export function when you want to: 
 give a copy of your data to a service bureau, 
 copy your data into another program on your or another’s 

computer, 
 swap lists with another nonprofit. 

 
The process of exporting is relatively straightforward. It involves three steps: 
choosing the data, choosing the format, and deciding where the file should 
be exported to. 
 
Which data style do you want? 
You can pick and choose from the list of fields in the list on the right side of 
this window, or you can select one of these styles, each of which has pre-
selected fields, after which you can add or remove fields from the list by 
checking or unchecking fields. Click on Clear Selections to clear the check 
marks from all fields. Be wary of using the two-file style. This requires a 
professional or a high-quality “hacker” to work with it. This is because there is 
one record for each donor in the FRBNAMES file, but there may be several 
records (one for each contribution) for each donor in the FRBGIFTS file.  What 
export file type do you want? The first two, dBase and comma-delimited 
ASCII, are the two most common data file types used for transferring data 
from one system to another.  Service bureaus invariably prefer ASCII, while 
many database people prefer dBase. The fixed length file type is mostly used 
only by the big mainframe people these days. Except for two conditions, all 
data will be contained in one file, FRBNAMES.xxx: 

 if you select all data, including notes and giving history, then the 
gifts will be included in a separate file named FRBGIFTS.xxx 

 if you export the Notes field in a dBase file, then the notes will be in 
a separate file named FRBNAMES.DBT. This second file must always 
accompany the main DBF file - they go together as a set.   

 
File Types and Extensions 

 dBase files will have an extension of DBF (or DBT for the file 
containing the notes) 

 Comma delimited ASCII files will have an extension of TXT. 
 Fixed length ASCII files will have an extension of SDF. 
 

If you choose either of the two ASCII files, you will be given an opportunity to 
print the field names in the first record. This has become a common practice 
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 - it is a courtesy that helps the person who must import the data to 
understand what the pieces of data mean. You should usually leave this 
checked. 
 
Where do you want the file(s) exported to? 
Click on the folder icon to change the location. Print out the file 
specifications when exporting.  This will print one page per exported file, 
detailing the field names and giving a description for each. The person you 
send your file to will very much appreciate these sheets.  To begin the Export, 
click on the Export button. 
 
File Maintenance 
In FundRaiser Basic, when you delete a donor name or other record, you are 
actually just marking it for deletion. It is not erased from your computer until 
you run File, File Maintenance, which causes any records which had been 
marked for deletion to be physically erased.  
 
File Maintenance has a second, very important, purpose: rebuilding index 
files. Over time, index files can get out of sync with the data files they relate 
to; so, as a good housekeeping measure, you need to rebuild the index files 
on a regular basis. If you use FundRaiser on a daily basis, you should run File 
Maintenance once every week or so (if not more often); otherwise, once a 
month is generally enough. It doesn’t hurt to run it more often. Also, if you 
ever experience a disk error, you should include File Maintenance in your 
recovery process: 

 Run ScanDisk to find and fix any disk errors. In Windows98 and 
newer, and in some newer versions of Win95, Windows does this on 
startup if it was not shut down properly. If running an older version of 
Win95, click on Start, Programs, Accessories, System Tools, 
Scandisk. Choose the Standard test, and tell it to automatically fix 
errors. 

 Make a backup. 
 Run File Maintenance. 
 Run Data Integrity Check. 

There are some clues to watch for which indicate that the indexes are out of 
sync with the data: when you search for a name that you know is there, but 
FundRaiser can’t find it; or when you get a report that seems to have the 
wrong names listed for the criteria you selected. If you run File Maintenance 
regularly, you should not see these problems occur. 
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 Check Data Integrity 
Computers inevitably fail. When that happens your data may become 
corrupted. This menu choice will help you make sure that your data is in 
good shape. When you run this, you can have it look over your data without 
fixing it, and that is what we suggest you do first. If the resulting report 
suggests that you run it again to make some fixes, then you can put a 
checkmark on that option. (When you do so, a checkmark will appear in the 
“Make Backup” option, and you should leave it checked in chase you need 
to restore your data if the fix fails for any reason.)  This routine tests four things: 
 

1. Duplicate Account Numbers: One problem that can result from corrupted 
data is that FundRaiser can erroneously assign duplicate account numbers to 
new records. This results in contribution data being “shared” between the two 
accounts that have the same account number. The fix is for FundRaiser to 
assign new account numbers. You may also have to do some manual  
deleting and re-entry of gifts. 
 
2. Data Scan: In this portion, FundRaiser will look at every character to make 
sure that it is readable. If not, it will report it as an error. The fix is to blank out 
that portion. 
 
3. Verify Account Numbers: FundRaiser account numbers are always six 
digits. If the number is a short one, like 123, then it pads the number with 
zeros, giving you 000123. If any Account Numbers are invalid, FundRaiser will 
let you know. The fix depends on the problem. 
 
4. Orphaned Gift Records: If a donor’s Master record is lost, the contributions 
may still exist in the Gifts database. This portion looks for any gifts that do not 
have a Master record (where the name and address are kept). The only fix is 
to delete those contributions. 
 
Recalculate Giving Totals 
This File Menu choice recalculates the totals displayed in the Details tab in 
the main donor screen. It may safely be run anytime, but is only needed at 
the beginnng of a new year or after a data error. 
 
Recreate Code Dropdown Lists 
This feature, which scans through your lists, looking for new Category or Gift 
Source codes, needs to be used only if something happens to your 
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 dropdown lists so that they are no longer complete. When you click on this 
menu choice, FundRaiser Basic will scan your databases and add any new 
codes to the dropdown lists. You’ll be given a chance to view the lists and 
delete any codes that aren’t needed. When you’re satisfied with the lists, 
click on the Update button. 
 
Edit Menu 

Cut    This copies the selected text to the Windows Clipboard  
   and deletes it from the screen. 
 
Copy    This copies the selected text to the Windows Clipboard,  
   but does not delete it from the screen. 
 
Paste    This inserts the contents of the Windows Clipboard at the  
   cursor position. 
 
Delete   This deletes the selected text without copying it to the  
   Windows Clipboard. 
 
Add Donor   This clears all the current fields, and prepares FundRaiser  
   to accept a new donor record. Click on this when you  
   want to add a new donor. 
 
Delete Donor  This marks the current donor for deletion. It does not  
   permanently erase the record - that is done during File  
   Maintenance. While the record is marked for deletion, the 
   word Deleted appears in red in the center of the   
   navigation control. The delete button and this menu  
   choice also change to “undelete”, giving you a chance  
   to remove the record from the deletion list before File  
   Maintenance is run. 
Adding new donors It’s easy to add a donor record to FundRaiser. Just  
    click on the Add button and fill in the blanks. 
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 Do you need to enter prospects differently than donors? No. FundRaiser 
keeps track of who has given and who has not, so you should enter them all 
the same way in one list. 
 
Do you need to enter them in alphabetical order? No. FundRaiser handles 
that for you, too. 
 
Do you need to use all UPPER CASE letters? No. Just type the names and 
addresses the way you want them to appear in letters. If your postal system 
requires that addresses be in all UPPER CASE, you can instruct FundRaiser to 
print them that way on envelopes or labels for you. You do so in the Options 
Menu. 
 
Here is a breakdown of each of the fields. 
 
Donor Type: Click on either Individual or Business. An Individual will have 
both a first and last name; a business (or other type of organization) has one 
name. This also affects how the default salutation and mailing name fields 
will be created. (See Options Menu, Name Defaults.) 
 
First Name : This is the donor’s first name. If it is your practice to enter a 
middle initial, this is where to enter it. If the donor has a title, do not enter it 
here. Save it for the Salutation field and the Mailing Name field. 
 
Last Name: In addition to last name, you should enter any suffixes (such as 
Jr., Sr., III, PhD, etc). 
 
Business Name:  In the case of businesses, you will enter a single business 
name instead of first and last. If the business begins with an article (“a” or 
“The”), it is usually best not to enter that in this name. It should, of course, be 
entered in the Mailing Name field. 
 
Spouse First, Last:  This is the name of the donor’s spouse, if any. This may also 
be a non-married house-mate or partner whom you wish to associate with 
the donor. 
 
Contact First, Last: In the case of a business, this is the name of your contact 
at the business. 
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 Salutation: This is what will be merged into the “Dear ...” portion of a letter. It 
should not begin with Dear or end with a comma or colon. Enter only the 
name. FundRaiser will fill in this field for you depending on how you have the 
entry in Options|Name Defaults configured. 
 
Category 1, 2 & 3 : These fields are user-definable fields. While we suggest 
that you use them to categorize your donors (board member, volunteer, 
activity, interest, etc.) and donor source (how you obtained the name), etc), 
you may use these for any purpose whatsoever. You may change the 
captions for these fields in the Options Menu. 
 
Phone Numbers: The first two fields are 20 character fields in which you can 
enter home and work phone numbers plus a note or extension at the end. 
The default format is for North America. You may select an open format in 
the Options Menu. 
 
Address Tab 
Optional/Contact: In the case of Individual donor types, this field is rarely 
used, hence the “Optional” title. Use it only when you need an extra line in 
your address block. In the case of Business donor types, this field is used to 
enter the name of the Contact person at the business. 
 
Mailing Name: This is the name of the person or organization that “owns” this 
address. In the case of an Individual donor type, it is the name of the 
Individual. In the case of businesses, it is the business name. 
 
Address 1: In the US, this address line is secondary to Address 2. If you have 
only one address line, it should be entered into Address 2. 
 
Address 2: In the US, this is the primary address, the one to which the post 
office delivers the mail. 
 
City: The city name. It should not contain any postal codes or other 
information. If you have commonly entered cities, you can add them to the 
dropdown list via the combobox. 
 
State: The state code. FundRaiser comes with a complete listing of US and 
Canadian state and province codes. You can add to the dropdown list 
through the combobox. 
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 Zip, Postal Code : The US Zip or other postal code. If you have some 
commonly used zip or postal codes, you should add them to the dropdown 
list via the combobox. 
 
Country Code:  If the address is for a country other than your own, then you 
will want to select the proper code for it from the dropdown list. 
 

International Addresses 
When designing FundRaiser, we tried to accomodate all the different 
variations in addressing found around the planet. We think we’ve come 
close in handling them all with relative ease on your part. You just need to fill 
in the different address fields, and let FundRaiser configure the address block 
at printing time. FundRaiser has a complete listing of all the countries, 
including their addressing standards. FundRaiser uses that knowledge to shift 
the various address fields around to their proper positions in the address 
block for that country. 
 
A common example is moving the postal code to the left of the city name for 
the many countries that follow that standard. The address block for some 
countries is the exact opposite of how it is configured in the US. FundRaiser 
can handle all of that with ease. 
 

Adding Gifts 
When you have a batch of contributions to enter, we suggest you follow a 
standard Basic Routine:  First, Search for the donor in the existing list. If not 
found, Add the donor. Then click on the Gifts Tab, then click on the Add 
button and record the following information: 
 
Amount : This is the amount of the contribution. If you are recording In Kind 
contributions, enter the fair market value of the donation. In the US, the IRS 
requires that the donor (not your nonprofit agency) provide proof of the 
value of the donation. You should provide a letter or receipt that describes 
the donation in enough detail that it is clear what was given. 
 
Date Given:  This is the date when the donor gave the contribution. In the US, 
the IRS has ruled that the postmark is the official date given. This is most 
important at the end of the tax year when the date on the check may be in 
one year, and the postmark in the next. Other choices are to enter the date 
on the check, the date you received it, or even the date you deposited it in 
the bank. The key is to stay consistent. (See also: Donation Report.) 
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 Source: This is an optional field. Use it to record what activity or event 
prompted the donor to give this gift. Examples include: a mailing (a 
newsletter), a special event (a dinner or auction), a personal visit. 
Oftentimes, a gift will be sent without any prompting on your part. In this 
case, you can leave it blank or can enter “No Apparent Reason”. Why 
bother to enter “No Apparent Reason”? Because you may want to set a 
Query based on those who have given with this Source. 
 
Clicking on the pencil icon will give you access to the ComboBox in 
which you can add, edit, and delete Source entries. 
 
Send a Thank You Letter or Receipt:  When this is checked, this donation (and 
donor) will be included in a list of Thank You letters to be batch-printed. To 
print, click on the Printing Menu|Letters and choose “Marked Gifts (for thank 
you’s)”. If you do not want to batch-print a thank you for this gift, uncheck 
this entry. When done, click on the OK button to save. 
 
Checking the accuracy of contribution entries 
 
After you enter a batch of contributions, it is wise to check that you entered 
them accurately, by following these simple steps: 

1. Click on the Print menu, then on Donation Report. Leave all the 
defaults unchanged (to include only contributions that were entered 
today), and click on Print. 

2. Compare the report total to the total that you have manually 
calculated. If the totals do not match, then compare the amount on 
each check (or cash receipt) to the amount on the report. Make 
any necessary corrections by first Searching for the donor and then 
Editing the gift. Then re-run the Donation Report. 

3. We suggest that you print a “hard copy” (print on paper) of the 
Donation Report for each batch of contributions. This can be given to 
your bookkeeper, or filed in your records. If your computer fails and 
you discover that your most recent backup isn’t very recent (tsk 
tsk!), you’ll be glad to have these archived Donation Reports! 

4. Finally, print thank-you letters -- remember to “thank before you 
bank”. 
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 GoTo Menu 
 
 
 
 
 
 

These menu choices cause the program to move to a different donor record 
in the database, and change which donor is displayed in the main Donor 
Screen. The current order (the order in which the records are arranged and 
displayed) may be changed using the Navigation Control; (see page 12) 
and affects these movement commands. 
 
First    This moves to the first record in the database. 
 
Last    This moves to the last record in the database. 
 
Next    This moves forward one record in the database. 
 
Previous   This moves backwards one record in the database. 
 
Last Added   This moves to the record that you last added into  
   FundRaiser. 
 
Search Menu 

 
 
 
 
 

Search 
There are three ways to search in FundRaiser. All of them start with clicking 
on the Search Button, either in the main Donor Screen or in the Browse 
Window, or by choosing Search from this Search Menu. 
 
Search by Name  The most common method of searching is by name. 

Click on the Search Button, and then on the Find 
Name tab if it is not already selected. Enter the 
donor’s last name and as much of the first name as 
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 it takes to make a unique entry.  Sometimes, you 
need enter only a portion of the last name. For 
example, to find a rare name like Horatio 
Dragonwagon, you need only enter Dragon in the 
Last Name field. No first name is needed, because 
there is probably only one Dragonwagon in your list. 
If, on the other hand, you are searching for a com-
mon name, like Smith, then you will probably need 
to include the first name as well as the complete 
last name. For example, Smith for Last Name, 
Donald for First Name. 

 
Once you search by name, if the name you are seeking is not the one you 
want, you can either move forward through the list by clicking on the next 
record button, or you can click on the Master List tab in order to view 
multiple records at a glance. 
 
All Fields    If you are trying to find a donor by another field,  
    perhaps by a part of an address, but are not sure 
    where in the address the word might have been  
    recorded, you should choose All Fields on the Other 
    Fields page of the Search Window. FundRaiser will  
    quickly look through all fields (except notes and  
    gifts) to find your entry.  Once FundRaiser finds a  
    match, it will display the donor record and ask if  
    you want to continue Searching or if you are ready  
    to cancel the search. If you click on Cancel, then  
    later want to continue the Search by the same  
    criteria, just click on the Search Again button. 
 
Another Field   If, on the other hand, you know exactly which field  
    you want to search in, then you should select that  
    field from the drop down list of fields on the Other  
    Fields page. When you click on the Start button, the 
    search proceeds in exactly the same manner as  
    with All Fields above. 
 
Search Again  Clicking on this button, or menu choice will Search  
    for the next instance of your Search criteria. If you  
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 are Searching though All Fields, then the Search 
may continue within the current donor’s fields. 
 

Query Window   
In this window you enter criteria by which FundRaiser selects donors and 
prospects from your list.  These selected donors may then be viewed in the  
main Donor Screen, printed, or exported.  You may enter as many criteria as 
you wish (well, actually, there is a limit, but it is very large and not one you 
are likely to encounter). Each criteria will be treated as a required criteria - it 
is not an EITHER - OR condition. For example, if you enter a zip code range 
and a Gift Source, then all selected donors will meet each criteria, not just 
one or the other. 
 

TIP: Use as few criteria as you need. Some criteria overlap and you may 
inadvertently cause one to conflict with another. For example, the “Gave 
Any Amount During” and the “Gave ...But Not Since” can give the same 
result if the date range is “3 months ago through today”. In this case, it is best 
to choose one or the other. If you want to see if there is any difference 
between two similar criteria, then it is best to run two separate queries, and 
compare the results. 
 

Donor Fields 
Category, Donor Source These are fields that you are able to assign a 
different caption (title) to (through the Options Menu), so they may appear 
differently on your screen. Click on the drop-down button to select from a list 
of existing entries. If you do select an entry, then only those donors with this 
code will be included in the query. Leave it blank if you want donors 
regardless of any entries in these fields. 
 

Donor Type    This defaults to both Individual and Business types,  
    but you can change it to just one or the other. 
 
Zip Code Range   If you want donors from a particular geographical  
    region, enter a beginning and ending postal code.  
    Both sides are inclusive. You may enter partial  
    postal codes. For example, 7 through 79999 will  
    select donors from zip codes 70000 through 79999.  
    Because “8” comes before “80000” for a computer,  
    you can also enter 7 through 8 and get the same 
    result. 
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 For Canadian users, please be aware that, especially on the right side of the 
range, the code you specify must be a full postal code, or you can use the 7 
through 8 trick explained above.  
 
For example, T2W through T2W 9Z9 will give you all donors living in the T2W 
region. You could also enter T2W through T2X; however, entering T2W through 
T2W will give you no donors, since no donors will have a postal code of just 
T2W.  
 
Do these rules seem arbitrary and a little unnatural? They are not our rules - 
they are based on the peculiarities of the way computers are designed. 
There actually is some logic to all this, but we won’t bore you with it here. It is 
best just to remember the patterns and abide by them. 
 
Has Email   Put a checkmark here to select only those records that  
   have an email address. 
 
Gift Fields 
Gave Any Amount During this date range : 
This will give you donors who gave any amount (a penny or more) sometime 
during the date range that you specify. An example of this criteria is when 
you want a list of everyone who donated last year. 
 
Caution: do not make the mistake of thinking that this date range combines 
with the amount range to its right. If that is your intent, then you should 
instead use the combination date range and amount range at the bottom of 
this window. 
 
Total Amount Given to Date: 
FundRaiser keeps track of the total amount that each donor has given over 
time. This amount is displayed in each donor’s Details page as “Total Given”. 
For example, if a donor gave 50.00 this year and 30.00 last year, then this 
figure will be 80.00.  
 
“Total Amount Given is Zero”:  
Check this if you want those who have never given a donation. 
 
Gave during this date range, but not since then:  
This is the date of the donor’s last gift. 
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 It can be used to create a common LYBUNT (Last Year But Not This Year) or 
SYBUNT (Some Year But Not This Year) group to find your lapsed donors. 
 

LYBUNT - Enter a date range of the first through the end of last year (in 
2011, this will be 01/01/2010 through 12/31/2010). 
 
SYBUNT - Enter a date range of 01/01/1970 through the end of last year. 
You might also think of this range as a “Have not given since” range. 
For example, if you want a list of everyone who has not given since 
12/31/2010, enter a range of 01/01/1970 through 12/31/2010. 
 

Gift Source : 
Select a Source entry from the drop down list if you want only those donors 
who have given a donation with a particular Source. As an example: if you 
want a list of everyone who bought a ticket to the 2009 banquet so that you 
can send them invitations again this year, select the 2009 Banquet source 
entry from the drop down list. 
 
Gave Between these dates . . . with amount ranging from . . . : 
This combination of date range and amount range is used for situations like: 
you want to send one letter to those who gave less than one amount, and 
another to those who gave more. 
 
For example, if you want to send one particular end-of-year letter to all those 
who gave less than $50, then you would enter the dates for last year and an 
amount range of 0.01 thorugh 49.99. With this Query, you would then print 
those letters and labels. Then you would set a second Query for the same 
date range and change the amount range to 50.00 through 999999999, and 
then print a different letter for those people. 
 
Set Query Button: 
 Click on this button when you have your criteria set and are ready to 
process it. Please be aware that if you have a large list, it may take more 
than a few moments to process your query. When it has done so, it will close 
this Query Window and return you to the main Donor Screen, where you can 
view your donors, Browse, Export, or Print. 
 
Cancel Query Button:  Click on this button if you decide not to process your 
query or if you want to end a previously processed query. It will close the 
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 Query Window and return you to the main Donor Screen where all donors will 
again be selected. 
 
Clear Fields Button: 
Click on this button to clear all the criteria and to start over again. You will 
remain in this Query Window. 
 
Close Button:  This causes you to exit the Query window. 
 
Some Final Notes and Cautions 

 Test your Queries, especially while you’re still learning. Look through 
the resulting records to make sure that everyone is there who 
should be, and that no one is there who shouldn’t be. If you find any 
discrepancies, then review your Query criteria. If you can’t find the 
problem, contact our Tech Support and we’ll be happy to go over it 
with you. 

 When you set a Query, it selects donor records. It does not 
determine which gift records will appear in reports. When you set a 
query, all of a donor’s data stays with him/her. 

 When you print a report, the report will be able to see all of the gifts. 
To limit the gifts that appear in a report, you must limit it using the 
report’s criteria (if there are any; some have no way of limiting the 
gifts). 
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 Print Menu 
 
 
 
 
 
 
 
 
 

Letters: 
This takes you to the Print Letters window, in which you can print a letter for 
one or more donors. 
 
Labels: 
This takes you to the Print Labels window, in which you can print labels for 
one or more donors. 
 
Envelope: 
 This takes you to the Print Envelopes window, in which you can print 
envelopes for one or more donors. 
 
Mark Thank You’s Done: 
 Once you have finished printing thank you letters or receipts, plus any labels 
or envelopes, using the above menu choices, you must remove the Send-
Thank-You mark from the contributions so that you do not re-print letters or 
labels for these same donations when you next print. This menu choice does 
that for you. (If you forget to take this step, FundRaiser will remind you when 
you exit the program.) 
 
Donation Report: 
 This report lists contributions in date order that were given during a particular 
date range. It is ideal for use as a bookkeeping report. Be aware that this 
reportrespects the results of an active Query.  It can also be printed as a 
Deposit Report, in which all contributions entered on a particular day are 
listed. This report is suitable for inclusion with your bank deposit. It is also an 
integral part of the basic routine that we suggest you follow when you enter 
contributions. 
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 Donor Reports : 
This is a collection of 8 different donor listings. If you want to print a listing of a 
subgroup (not your entire list), then you should first set a query in the Query 
window.  

 “One-liners” are just that. Information for each donor is contained 
on one line. This makes for a very readable report, with nice neat 
columns. But the information is abbreviated. The specific fields are 
listed. 

 “Multi-line” reports give more information that spans multiple lines.  
 
To get a feel for which reports will be most useful for you, we suggest you 
print a sample of each (in Print Preview, choose a single page to print). 
 
Major Donor Report: 
 This report was originally designed to help you fill out section IV-A of the IRS 
Form 990 (in the US). It shows you who your major donors are, and how much 
they’ve given over the past few years. The defaults for determining just who 
your major donors are meet the IRS requirements for their form (those who 
have provided 2% or more of all your donations over the past five years). You 
can easily override these defaults by setting a dollar figure instead or by 
changing the percentage. 
 
Word Processor: 
 This opens the FundRaiser Word Processor, in which you can create and edit 
letters and other documents. You can use this separate program for any or 
all of your word processing tasks. You will find that it has its own icon in the 
FundRaiser program group, and the “WP” button on the button bar will open 
this applet for you, too. 
 
Email: 
This option will open your default E-mail client and insert the donor’s E-mail 
address into a new E-mail message. 
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 Print Letters 

To access this window, click on the Print Menu, then on Letters. 
 

Print Letter Now For: 
 Current Donor: This is the donor that is currently displayed. One letter will 

be printed. 
 All Donors: If you have no Query set, this is all donors in your database. If 

you have a Query set, this will print a letter for every donor that meets the 
 Query criteria. 
 Donors in Que List: This prints one letter for every entry in the Que. 
 Marked Gifts: This prints a letter for every contribution that is marked to 

receive a thank you letter. 
 Choose Letter to Print: This is the name of the letter to print. The default 

letter is “ThankYou.rtf” in the FundRaiser Basic folder, but you can choose 
any letter you wish. You must either type the name of the letter directly, or 
select it from a browse window. The letter must be an RTF (rich text format) 
type letter. You may create it with the FundRaiser Word Processor. If you 
use a commercial word processing program, like MS Word or 
WordPerfect, to compose FundRaiser form letters, it is quite likely that 
those programs will insert RTF commands into the letter that FundRaiser will 
not understand. We get quite a few calls from people who ask why their 
letter looks so awful, or why it locks up FundRaiser. Using an “outside” 
word processor is usually the cause of the problem. 

 Print Button: Click on this button when you are ready to preview the 
merged letters and/or to start printing. 

 Close Button: Click on this button to close this window and cancel 
printing. 
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 Thank You Letters 
 
Why send a Thank You?  Thanking your donors is an essential part of the 
fundraising process. It lets them know that you have received their check. It 
gives you an opportunity to make them feel good about having given. It 
gives you an opportunity to remind them of the good work that you do (with 
their help). And it gives you an opportunity to make it easy for them to give 
again (include a pre-addressed envelope). 
 
Most important is that it helps to build a relationship with your donors, which 
is essential to any long-term fundraising strategy. Even if all you do is print a 
label that you slap on a post card, it is important that you acknowledge 
each and every gift. The only exception is when the donor specifically asks 
that you not send acknowledgement letters. One fundraising consultant says 
repeatedly, “Thank before you bank.” Which means that before you take 
your deposits to the bank, you should take your thank you cards and letters 
to the post office. 
 
If you feel that you can’t afford to send a letter in response to every donation, 
then send a post card, or email for smaller donations and letters for larger 
ones. Whatever you do, it is absolutely critical that you acknowledge each 
and every contribution. 
 
How do you print Thank You letters? 
 
When you add a new contribution, enter a check mark on “Send a Thank 
You letter or receipt?”. Once all your contributions have been entered, click 
on the Print Menu, then on Letters (or labels or envelopes), and then on 
“Marked Gifts (for thank you’s)”. In that same window, choose the letter that 
you have created in FundRaiser’s word processor to be printed. 
 
FundRaiser will then print your letter once for each contribution that has the 
“Send a Thank You...” checked. After you have printed everything (letters, 
labels, envelopes) for those contributions, you need to remove the check 
mark from the printed contributions. Do this by clicking on the Print Menu, 
then on “Mark Thank You’s Done.” If you fail to do this (FundRaiser will remind 
you if you forget), then the next time you print Thank You’s, these same 
contributions will be included in the printing - again. 
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 What should go into a Thank You letter? 
 
See the sample letter (ThankYou.rtf) that comes with FundRaiser. 
It should be one page if possible. It should thank the donor in the first 
paragraph and at the end. It should remind them of what you do, preferably 
by telling a story or by relating a personal, emotional, human incident (which 
should be different each month). It should acknowledge that you would not 
be able to do your work without their continued support. Encourage them to 
give again (“I look forward to hearing from you again.”) 
 
What should go into a post card, or Email? 
 
Thank them. Remind them of what you do and why. Thank them again. 
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 Printing Labels: 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on the Print Menu, then on Labels to access this window. 
 
Print Label Now For: 
 Current Donor: This is the donor that is currently displayed. One label will 

be printed. 
 All Donors: If you have no Query set, this is all donors in your database. If 

you have a Query set, this will print a label for every donor that meets the 
Query criteria. 

 Donors in Que List: This prints one label for every entry in the Que. 
 Marked Gifts: This prints a label for every contribution that is marked to 

receive a thank you letter. Labels will be printed in the same order as the 
letters for easy matchup. 

 Starting Position: This determines where on the sheet the first label will be 
printed. This is most useful when you have a sheet of labels that has 
already been partially used, not wishing to waste the sheet, you wish to 
start printing in the middle of the sheet. For example, if you have a sheet 
of labels that are 3 across by 10 down, and the first 5 labels have been 
used (1st row plus the two on the left of the 2nd row), then you would set 
the Starting Position to be Row 2, Column 3. 

 Label Type: This is the currently selected label. If you wish to change this, 
click on the Options button. 

 Print Button: Click on this button to preview the labels and/or to start 
printing. 
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 Close Button:  Click on this button to close this window and cancel printing. 
Options Button: Click on this button to select a different label type, to adjust 
the margin settings or font, or to create a new custom label definition. 
 
Label Options 

To access this window, click on the Options Button in the Label Printing 
window. Use this window to choose a new label type or to make adjustments 
to the currently selected label. Click on areas of this window for a description 
of that area, or scroll down below the window for all information. 
 
 Mailing Label Type:  Choose your mailing label type from this list. Avery 

uses a different thousand series for clear labels and for colored labels. For 
example, 6160 labels are the same as 5160 labels except they are clear, 
and 8160 labels are the same as 5160 labels except theyare colored. 
Also, some other brands of labels will tell you which Avery label # their 
labels are equivalent to. 

 Custom Label Name: If “Custom Label” is selected, you may give it a 
name in this box. 

 Number of Labels: (these are not editable) 
 Across page: this is the number of labels in each row.  
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  Down page: if you are printing on an inkjet or laser with cut-sheet paper, 
this is the number of rows on a sheet of labels. If you are printing on a dot-
matrix or other printer that uses continuous feed labels, then this should 
always be set to 1 row, even though there may be several rows per 
perforated sheet. 

 Page Margins: 
 Top Margin: this is the distance, in inches, from the top of the paper 

to the edge of the label. 
 Left Margin: this is the distance, in inches, from the left edge of the 

paper to the left edge of the first column of labels. 
 Label Size: This is the measured size of the label itself. 
 Gap Between Labels: On some sheets, the labels touch each other, in 

which case there is no gap, and this should be set to 0. On other sheets, 
there are narrow strips that separate the labels. The width or height of 
these strips is the gap size. 

 Printing Direction: If you prefer that labels be printed in rows from left to 
right, choose “Across then down”. If you prefer that labels be printed in 
columns from top to bottom, then on to the next column, choose “Down 
then across”. 

 Font: Click on this button to access the Font Selection Window. 
 Label Border: This is the distance between the printing and the edge of the 

label. Set this to 0 if you want the printing to use all of the available space. 
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 Print Envelopes 

Click on the Print Menu, then on Envelopes to access this window. 
 
Print Envelope Now For: 
 Current Donor: This is the donor that is currently displayed. One envelope 

will be printed. 
 All Donors: If you have no Query set, this is all donors in your database. If 

you have a Query set, this will print an envelope for every donor that 
meets the Query criteria. 

 Donors in Que List: This prints one envelope for every entry in the Que. 
 Marked Gifts: This prints an envelope for every contribution that is marked 

to receive a thank you letter. Envelopes will be printed in the same order 
as the letters for easy matchup. 

 Return Address: If you want your return address printed on envelopes, 
remove the checkmark from Omit and enter your name and address in 
the block provided. 

 Options or Feed Button: Click on this button to change the manner in 
which you feed envelopes into your printer, or to change the fonts used, 
or placement on the envelope.  

 Print Button: Click on this button when you are ready to preview the 
envelopes and/or to start printing. 
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 Envelope Options 
 
 
 
 
 
 
 
 
 
 
 
 
 

To access this window, click on the Print Menu, then Envelopes, then on the 
Options button. 
 
 Feed Method: Choose the method in which you feed envelopes into your 

printer. You should change this only after trying the default method shown 
above. (on some printers this option fails) 

 Delivery Address and Return Address: Click on the Font Button to change 
the font characteristics to be used when printing this address. The word 
Font is displayed using the current font characteristics for this address. 

 The From Left and From Top settings determine the starting point, in inches, 
of the first line of the address. 

 Note: to disable the Return Address from being printed, check the 
Omit Return Address box in the Print Envelope window, which is the 
one immediately behind this window. 

 Restore Defaults: Click on this button to restore the original settings for the 
fonts and From Left/Top settings. 

 OK Button: Click on this button when you are satisfied with all the 
displayed settings. 

 Cancel Button: Click on this button to abandon any changes. 
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 Donation Report 
 
This report lists donations given (or entered) during the specified date range. 
Uses include checking for accuracy after entry of a batch of contributions, 
for a hard copy of contributions received (or entered) during the past month, 
or to give to the bookkeeper. Since it will also subtotal by Source Code, it 
can also be handy for seeing how you’re doing on a particular project. 
 
Report Based on: 
The report can be based on either the Date of Donation or the Date Entered. 
For example, to check the accuracy of a batch of contributions just entered 
today, select Date Entered. What real difference is there between these two 
types of dates? Take the common practice of entering a week’s worth of 
donations at one time. You will probably enter the check date or the 
postmark date as the Date of Donation, which will be different from the Date 
of Entry. If you print this report for Date of Donation, you will specify the entire 
week, instead of the one day that you are sitting at the keyboard. So far, 
there is no problem.  
 
But, what if you also receive a contribution that arrived late, and has a date 
from last month? A report based on Date of Donation will miss that 
contribution unless you include its month-old date, in which case the report 
will include all the other contributions for that period. Ah, you say, but I enter 
the current date as the Date Given, so it doesn’t matter. Perhaps. However, it 
is possible for you to mis-enter a date, in which case it will not appear on the 
report if you select Date of Donation. It is always best to use Date of Entry 
when you want all contributions entered on a particular day. 
 
For a report listing contributions given (but not necessarily received) during a 
date range, select Date of Donation. 
 
Date Range:  This range determines which contributions will be included in 
the report. The default date range is always today. You can change the 
dates by typing them in directly, or by accessing the pop up calendar by 
clicking on the ellipses. 
 
Gift Source: If you want to include only contributions with a particular Source 
Code, select it from the dropdown list. Otherwise, leave this set to All. 
 



GETTING STARTED WITH FundRaiser Basic                              46 

www.FundRaiserSoftware.com  Support@FundRaiserSoftware.com 

 Include Source Code Totals: If you do not want subtotals for each Source 
Code displayed at the end of the report, uncheck this box. 
 
Print Button: Click on this button when you are ready to prview and/or print 
the report. 
 
Close Button: Click on this button to cancel the report. 
 
 
 
 
 
 
 
 
FundRaiser’s Built-In Word Processor 
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 FundRaiser’s Built-In Word Processor 
 
FundRaiser’s built in word processor is similar to the WordPad program that 
comes with Windows, except that it also has built-in merge function picklists 
that make it easy for you to build and test form letters. If you’re not all that 
familiar with word processors, we’ll introduce you to the basics on the next 
page. 
 
If you use a commercial word processor, like MS Word or WordPerfect, to 
compose your form letters and then bring them into FundRaiser, it is likely 
that the finished product will not be what you want. Those programs often 
insert RTF commands into the letter than FundRaiser cannot understand, and 
then cause problems when printing, like leaving out whole lines of text, or 
even locking up FundRaiser altogether. It’s better to compose your letter in 
FundRaiser from the start. 
 
Printing is done from the Print menu; so when you’re finished composing and/
or merging data into your letter, return to FundRaiser Basic and click on the 
Print menu; you may Preview your letter before printing. 
 
Merge Fields and Functions 
Merge fields and functions are set off from the text of a letter with square 
brackets plus a leading red percentage sign. For example, This brings your 
total given this year to $%[YEARTODT]. Note that a leading $ (or other 
currency symbol) is part of the text of the letter, and not part of the merge 
field. It is needed because the merge fields and functions insert numbers 
without any currency symbols. The above example, when merged, will 
display as: This brings your total given this year to $45.00. 
 
The picklists of fields and functions are, by default, displayed on the right side 
of the screen when you come into the Word Processor. If you prefer not to 
have them displayed, click on the Hide Merge Fields button. 
 
The top-most of the two lists contains the mergeable fields from the master 
file. To insert one into your letter, click on the desired field to select it, then 
click on the Insert db Field button. The lower list contains mergeable 
functions that take data from either of the two database files and manipulate 
them in some way. Several of these will ask you simple questions about how 
you want the function configured. 
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 Tabbed Pages 
You’ll see two tabs at the bottom of the window: Form Letter, and Merged 
Letter. The Form Letter tabbed page is where you do your composing and 
creating. Switch to the Merged Letter tab to see how your letter will look with 
actual data merged in. This data is false (Mickey Mouse is probably not a 
name you have in your database!), and is there just to show you what your 
letter will look like when it prints (with real data). 
 
Word Processor Basics 
 
The Word Processor is used to create and edit letters. It looks and works 
much like Windows WordPad; it’s a fairly simple text editor program. It does 
not have all the bells and whistles of a full-featured word-processing 
program, like Word or WordPerfect, but it will allow you to compose and print 
perfectly acceptable thank-you and appeals letters.  
 
If you’re at all familiar with WordPad or any other Windows word-processing 
program, you won’t need to learn much in order to use FundRaiser’s Word 
Processor. The Menu Bar at the top is quite simple; the Tool Bar, too, won’t be 
anything new. Let’s look at each of the components of the Word Processor 
window. 
 
MENU BAR 
 
File: The File menu holds the usual Windows File functions: 
 
 New    start a new letter 
 Open   open a letter file previously saved 
 Save    save this letter using its existing name 
 Save As   name the file this letter (or version of this letter) will  
    be saved in 
 Print    print the text of this letter, showing merge functions  
    (not merged data) 
 Print Preview  see this letter’s form on the page 
 Page Setup   set paper size and margins, preferably before you  
    compose the letter 
 Exit    exit the Word Processor 
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 Edit: The Edit menu is also Windows-standard: 
 
 Undo  This “erases” the last command. For example, if you 

highlight a phrase and make it bold, and then  
decide you prefer it the way it was before, you may 
click on Undo, and the formatting will be erased. But 
you must Undo before you take any other action; 
this works only for the very last action you took. 

 Cut  This choice “cuts” (erases) any highlighted selection 
from your letter. It saves the text to the Clipboard. 

 Copy  This choice copies a selected portion from your 
letter, without erasing it, and saves it to the 
Clipboard. 

 Paste  Click here to “paste” the last-saved text from the 
Clipboard to the point in your letter where you’ve 
clicked an insertion point with your cursor. 

 Select All  This choice selects and highlights everything in the 
letter. 

 Find  This selection allows you to find a word or phrase 
within the text of the letter. For example, on proofing 
your letter, you find that you’ve misspelled the 
name of the person who is to speak at your next 
meeting. Now you’re afraid that you made the 
same mistake every time you used that name. Use 
the Find menu choice to look at each instance of 
that name to check your spelling. In the Find dialog 
window is “Match whole word only” which ensures 
that, for example, if you want to find the word “you”, 
the program will not bring up every variation of that 
word, like “your”, in addition. “Match case” allows 
you to search for only the word“Thank” with a 
capital T, and not any other instanceof “thank”. 

 Replace  Click here to find-and-replace words. Example: find 
all (or one) instances of “patient”, and replace it 
with “client”. Like the Find menu choice above, this 
function brings up a dialog which helps you control 
the replacing. If you want every instance of the 
word replaced, click on “Replace All”. If you don’t 
want every instance of the word replaced, then you 
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 go one by one, using the “Find Next” button, until 
you find an instance that you want to replace. At 
that point, click the “Replace” button. 
All of these choices, except Select All and Replace, 
have buttons on the Tool Bar which do exactly the 
same function; most also have keyboard shortcuts 
as well. 

 View  This menu allows you to tailor the look of the Word 
Processor window. The default setting is to have 
everything visible; you may click on each of 
Toolbar, Format bar, Ruler, and Status bar, to 
remove that choice from the desktop. Clicking on 
the Fields Panel toggles between Show and Hide 
Fields. 

 Font  Clicking here brings up a dialog box which allows 
you to choose Font, Size, and Style for the selected 
portion of text. These selections are also available 
on the Format Bar. 

 Help  Click here to access the Help system. 
 
 
 
TOOL BAR 
 
There are buttons on the Tool Bar for New, Open, Save, Print, Print Preview, 
Find, Cut, Copy, Paste, and Show/Hide Merge Fields. These all do just the 
same functions as their corresponding menu choices (see above). 
 
FORMAT BAR 
 
Buttons and drop-down lists here correspond to functions in the Font Menu, 
allowing you to choose/change Font, Size, and Color of selected text, as well 
as make it Bold, Italic, and Underlined. 
 
STATUS BAR 
 
This is the bar at the bottom of the window. It shows hint lines and other 
information.     
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 Mergeable Fields and Functions 
 

When printing letters, FundRaiser can merge data from your database into 
those letters. You indicate what data is to be merged by using mergeable 
fields and functions. It’s easy to do if you use FundRaiser’s Word Processor. 
 

ACCOUNT    The six-digit number that FundRaiser automatically  
    assigns to each donorrecord. 
FIRSTNAME    The donor’s First Name. 
LASTNAME    The donor’s Last Name or the Business Name. 
SPOUSEFRST    The Spouse First Name or the Business Contact First  
    Name. 
SPOUSELAST   The Spouse Last Name or the Business Contact Last  
    Name. 
SALUTATION   The form of the name that is typically merged into a 
    letter after “Dear “ at the beginning of the letter.  
    (Also see the merge function of the same name in  
    the next section.) 
HOMEPHONE   The donor’s Home Phone Number. 
WORKPHONE   The donor’s Work Phone Number. 
FAX     The donor’s Fax Phone Number. 
CATEGORY1   This is the field that you can rename that is located  
    on the Codes tab. 
CATEGORY2   This is the second field that you can rename, and is  
    located under Category 1 on the Codes tab. 
CATEGORY3   This is the third field that you can rename, and is  
    located under Category 2 in the Codes tab. 
CONTACT    First line on the Address tab, and top line of the  
    mailing label. 
MAILNAME    Second line on the Address tab, this line typically  
    contains the full name of the donor. 
ADDRESS1    Upper of the two address lines, this line will generally 
    be blank if there is only one address line. 
ADDRESS2    Lower of the two address lines, this line should  
    always contain an entry. 
CITY     The name of the donor’s city. 
STATE     State, Territory, or Province code. 
ZIP     Postal code of up to ten characters. 
COUNTRY    Five character country code. 
NOTES    The donor notes contained on the Notes tab. 
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 DONOR ENTRY DATE  The date that the donor record was entered into  
    FundRaiser.  
LASTGIFT DATE   Date that the donor last gave. This also means that  
    the donor has not given since this date. Also  
    viewable from the Statistics tab. 
LAST GIFT AMOUNT  The amount that the donor last gave. Also viewable  
    from the Statistics tab. 
ALL TIME TOTAL   The total amount that the donor has given over time. 
    Also viewable from the Statistics tab. 
TOTAL THIS YEAR   The total amount that the donor has given this year 
    (as defined in the Options menu). 
FIRST GIFT DATE   The date of the donor’s first gift. on the Statistics tab. 
LARGEST GIFT   The amount of the donor’s largest gift. 
LAST CHANGED   The date that you last made a change or updated  
    this record, including entry of a gift. Also viewable  
    from the Statistics tab. 
GIFT NOTE    Any note recorded with the gift. 
GIFT SOURCE   The Source Code of the gift. 
 
Mergeable Functions include: 
 
AddressBlock   This is equivalent to a mailing label. It contains all  
    the fields contained on the Address tab, arranged  
    appropriately for the default country (as set in the 
    Options Menu) or for the address’s country code.  
    Use this instead of the individual address fields. 
GiftAmount    This is the amount of the contribution. Which  
    contribution? If the letter being printed is a Thank  
    You letter, then the contribution is the one for 
    which the donor is being thanked. Otherwise, the  
    contribution is the most recent contribution, the one 
    at the top of the list on the Gifts page. 
This merge function has a “Combine” option that allows you to send one 
thank you letter for several contributions. If checked, FundRaiser will 
combine the amounts of all the donor’s marked gifts. The most common 
usage of this function (of which we are aware) is for churches who receive 
contributions each week from their donors. Rather than thank them for each 
and every contribution, a letter can be sent monthly or quarterly showing 
how much has been given since the last thank you letter was sent. 
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 GiftDate    This is the date of the contribution. As with the  
    GiftAmount function mentioned above, the  
    contribution referred to is the top contribution in 
    the donor’s Gifts page or the contribution for which 
    the thank you letter is being printed. If the Combine  
    option of the GiftAmount is selected, then the most  
    recent contribution is the one referred to. 
GiftList    This is a mini-report showing all the contributions for  
    a particular year or for all time. The amount, date,  
    and notes are printed for each contribution. 
    It is ideal for an End of Year letter. To avoid unsightly 
    ragged columns, use a font like Courier, which is  
    monospaced, for this report. 
GiftTotal    This is the total given over a period of time. You  
    specify the date range and FundRaiser totals the  
    contributions for that period. 
Salutation    This is the Salutation field or a word or phrase to use 
    if the Salutation field is blank. This additional word  
    ensures that you will never send a “Dear ,” letter. If  
    the Salutation field is blank, FundRaiser will insert  
    your preferred word or phrase, for example, “Dear  
    Friend,”. 
Today    This is the computer’s system date at the time of  
    printing. It is the “long date” in the format specified 
    in Windows’ Regional Settings (found in the Control  
    Panel). An example, using the US standard, is  
    March 28, 2012. 
 
Note: on some systems, the default “long date” includes the day:  
Monday, July 12, 2012. If you do not want your date displayed that way, 
click on the Windows Start button, then on Settings, Control Panel, Regional 
Settings. There you will see “long date” format. Remove the initial dddd , the 
click Apply, and you will see the sample date display properly. 
 
 



GETTING STARTED WITH FundRaiser Basic                              54 

www.FundRaiserSoftware.com  Support@FundRaiserSoftware.com 

 Options Menu 
 
 
 
 

The Options Menu consists of three sections, General Preferences, Name 
Defaults, and Skinning 
 
General Preferences  
 
The General Preferences section contains four tabbed pages. 
 
General Tab: 
 
Show Flyover Help on Toolbars:  If checked, FundRaiser will display short 
      messages when you pass over and  
      pause on a toolbar button. 
Drop Down List Automatically:   This is handy if you are keyboard  
      oriented. For a field that has a drop  
      down list, as you start to type, the list  
      will drop down and be positioned on  
      the existing entry that most closely  
      matches what you have started to type. 
User Defined Category Captions:  FundRaiser has category fields. You 
      can call these whatever is appropriate 
      for your organization. For example, if  
      your organization is a school, then you  
      may need one of these to be the  
      Graduation Year or Alumni Year.  
      (You can define the Category drop 
      down defaults from Adding a Donor) 
Country Your Organization Resides In:  This is used for two purposes, both  
      related to the printing of address blocks 
      (on labels, envelopes, and letters). First, 
      it will keep FundRaiser from printing the 
      name of your own country on labels.  
      Second, it formats addresses appropri-
      ately for your country.  FundRaiser has 
      detailed information on the addressing  
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       preferences for all countries. For  
      example, even though you enter the  
      postal code after the state code in the  
      main Donor Screen, FundRaiser will print  
      it to the left of the city if that is  
      appropriate for your country. 
Formats Tab: 
 
Working Calendar:    This is used when tallying the “Year To  
      Date” totals in the Details tabbed page 
      in the main Donor Screen. Select  
      Calendar Year if you want your totals  
      based on a year starting on January 1  
      and ending on December 31. Select  
      Fiscal Year, and specify the starting  
      month, if you prefer to have the totals  
      match your fiscal year. A common  
      example of an organization using the  
      Fiscal Year is a school whose year starts 
      in September. 
Telephone Format:    Most of our users are in the US and  
      Canada and share a common 
      telephone format. If this format does  
      not work for you, then you should  
      choose the “open format” in which  
      there is no limitation to what you can  
      type. 
 
Adding-A-Donor Tab: 
 
Default Type:     If most of your donors and prospects  
      are individual people, choose   
      Individual. If most are churches,  
      foundations, businesses, civic groups,  
      or other non-individual entities, choose 
      Business, even if they are not actually  
      businesses. A business will have one  
      name field (an individual has two: first  
      and last). Also, the fields for the  
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       secondary person are called Contact 
      for a business and Spouse for an  
      individual.  Another consequence is  
      that the default salutation and address  
      block name (see Name Default below) 
      can be different depending on type. 
Defaults For City, State, Zip,   If most of your donors are from one  
    Category1, Category2,   area, then you can save yourself a lot  
    Category3:    of time when adding a new donor, by  
      having FundRaiser enter the default  
      value that you enter in one or more of  
      these fields. 
Check for Duplicates on:   When adding a new donor, FundRaiser  
      can check for duplicates  
      automatically. If you check Last Name  
      and First Character, then it will check  
      the donor name and spouse name  
      each against both the existing donor  
      names and spouse names.  It checks  
      the full last name as you have entered  
      it, plus the first character of the first  
      name (thereby catching different  
      spelling variations, like Jim, Jimmy, and 
      James).  
      If you check Address, then FundRaiser  
      will quickly compare the state, city,  
      and address 2 line to others in the list.  
      Only complete matches will result in an 
      alert message. 
Printing Tab: 
 
Upper Case:   Some countries and even some local US post offices 
 require that labels and envelopes be printed in all 

upper case. Check this option if you need FundRais-
er to print in this manner. 

Strip Punctuation:   FundRaiser will remove all commas, periods,  
    apostrophe’s and other punctuation for you if you  
    need it to. For example, 123 Main St., Ste # 123 will  
    be printed as 123 Main St Ste 123.  
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 Name Defaults 
 
FundRaiser Basic has a space for the donor’s name in several places in the 
main Donor Screen. This is necessary because the manner in which you refer 
to someone changes depending on context. For example, you may start a 
letter with a Salutation of Dear Mary, but want her name on the envelope or 
label to read Ms. Mary Schmidt. We would never dream of requiring you to 
type each donor’s name three separate times, so we designed FundRaiser to 
do the work for you. 
 
The Name Defaults set of tabbed pages in the Options Menu determines how 
FundRaiser will formulate the default entry for each of the three fields, each 
of which has its own tabbed page, on which are four edit boxes. 
 
First, let’s talk about the patterns that go into each of the edit boxes. The 
patterns are formed by text plus merge fields. For example, Ms. <Last> will 
result in an entry like Ms. Schmidt. FundRaiser uses 5 merge fields: 
 
<First> and <Last> are the donor name for an Individual donor type or the 
Contact name at a business; <SpouseFirst> and <SpouseLast> are those of 
the spouse name; <Business> is the business name for a Business donor type. 
 
Each tabbed page has four edit boxes. The first three cover the three 
conditions when the Donor Type is marked as Individual. The fourth is for 
businesses. Each edit box has a dropdown list with several of the more 
common patterns. If one of these is not what you need, then you should type 
a new pattern into the edit box using the other patterns as examples. If you 
prefer to have no default, then leave the edit box blank. 
 
Individual - No Spouse: This is what FundRaiser will insert into the Salutation 
(or other field, depending on which tabbed page is selected) when no 
Spouse has been entered. As an example using the Salutation field, if most of 
your donors are male and you are formal in your communications, then you 
would probably use a default of Mr. <Last>. On the other hand, if you are 
informal, then the gender of your donors does not matter - you need only 
enter <First>. 
 
Individual - Spouse with same last name: When there is a spouse, and the 
spouse has the same last name as the donor (e.g., John Doe and Mary Doe), 
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 then this is the pattern that will be used. Common patterns for Salutation are 
Mr. and Mrs. <Last> for formal and <First> and <SpouseFirst> for informal. 
 
Individual - Spouse with different last name: When there is a spouse, and the 
spouse has a different name from the donor (e.g., Mary Doe and John Smith), 
then the pattern will almost always be different. For example, a formal 
Salutation might be Ms. <Last> and Mr. <SpouseLast>, depending on your 
prominent donor genders; however, an informal Salutation will probably be 
the same as when the spouse has the same last name as the donor: <First> 
and <SpouseFirst>. 
 
Business Contact: Defaults are much easier to formulate for businesses 
because there is only one person involved and the form of the name is 
usually formal in nature. The most common pattern for Salutation will be Mr. 
<SpouseLast> or Ms. <SpouseLast>. For Mailing Name, use <Business>. 
 
Skinning 
 
FundRaiser Basic has the ability to change the look of your database.  If you 
don't like the colors or how the buttons are shown, choose one of the listed 
skinning options or turn them completely off and let your Windows Theme 
control the look.  This does not affect your data in any way, just the way you 
see the program. 
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 Help Menu 

Help Contents:    Clicking on this menu choice brings up the  
     Help Table of Contents. 
Order Online Now:   When you’re ready to order, click here to go  
     to our Online order form. 
Enter Registration Code:   This is where you enter the code that you  
     received from us after your purchase. Once  
     you enter it, it “unlocks” FundRaiser’s printing 
     and exporting, and embeds your name in the 
     program. 
View Registration Code:  This option will show your currently entered  
     registration code. 
Other FundRaiser Programs: FundRaiser Basic is the entry level of the  
     FundRaiser family of donor management  
     software. This section talks about our other  
     programs. 
Support:     Of course you can contact us for help. This  
     explains our support policy and how you can 
     reach us. 
FundRaiser Website:  Link to our Website. www.FundRaiserBasic.com 
About:    Get information about the program.  You can  
     check which version of FundRaiser Basic is  
     installed on your computer. 
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 Help Contents 
 
Clicking on this menu choice brings up the Help Table of Contents. At this 
screen, click on a topic of interest for more information. If what you are 
looking for is not listed, click on the Index tab which will take you to a 
window with an edit box into which you may type the word or phrase about 
which you want information. As you type, the scrolling list will highlight topics; 
when you find the one you want, click on the Display button.  Or you can 
choose, Search tab, which will look for any word or phrase within the Help 
file. 
 
Order Online Now 
 
This will open your default web browser and show your our Online Order 
form.  Choose the product you wish to purchase and Fill the next forms to 
complete your order. 
 
Organization: This is the name that will appear at the top of reports and in the 
Help, About window as the “official” purchaser. 
 
First/Last Name: This is your name, or the name of the main contact person. 
This is the person to whom we will direct notice of updates. 
 
Mailing Address: Enter your complete address, including city, state, postal 
code, and country. 
 
Daytime Phone Number: We need this in case of problems with your order. 
Be assured that we do not sell our list to anyone. 
 
Email address: We will add you to the FundRaiser Basic Newsletter, which we 
use to send notices of updates. (This will be the main way of sending your 
registration codes, unless otherwise noted.) 
 
We accept payment by credit card, check (personal, business, or 
organizational), and money order. If paying by credit card, we must have 
the expiration date, and Security Code in order to validate your charge. We 
also need to have the name of the account holder: a person, or an 
organization, as it is listed on the card. 
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 Sales Tax: If you are not a resident of Missouri, then accept the default entry. 
If you are a resident, you must pay the current sales tax of 7.135% or provide 
us with a certificate of exemption. 
 
Enter Registration Code 
 
When you purchase FundRaiser Basic, you will receive a registration code 
that you must enter into the program. This code unlocks FundRaiser’s printing 
and exporting, and embeds your organization’s name in the program. 
 
To enter your code, click on the Help Menu, then on Enter Registration Code. 
 
Enter Your Registration Name: This is the name that you entered into the 
Order Form. It is also listed on the registration letter that you have (or will) 
receive from us. You must enter it exactly as shown on the letter, including 
UPPER/lower case and any punctuation and spacing.  The registration code 
is tied to this name, so any variance will cause the code to fail.  
 
Enter Your Registration Code: This is the code that you have received from us 
or one of our agents when you purchased FundRaiser. 
 
Permanent / Temporary: Select Permanent. We use two types of codes. The 
temporary code is good for 30 days. We (or our agents) give you this code at 
the time of purchase to let you use the program while waiting to receive the 
permanent code that is included in this package. 
 
When you have entered all three items, click on OK. If you mis-enter any of 
this information you will get an Invalid Registration Code message; just try 
again. You may try three times before the program will close. If that happens, 
you can start FundRaiser Basic up again, and try again.  
 
View Registration Code 
 
This will show your the current registration code entered into FundRaiser 
Basic.  This is helpful when a sending support request. 
 
Other FundRasier Programs 
To view information about other Products that FundRasier develops. 
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 Support 
Of course you can contact us for help! We provide support whether you’re 
still evaluating FundRaiser or have purchased it. If what you need isn’t in this 
manual, or in the Help system that’s built into FundRaiser Basic, you can look 
on our website, where there’s lots of information, or you can e-mail our super 
Tech Support team.  
 
Here is how you can reach us: 
Email: support@FundRaiserSoftware.com 
Web Page: http://www.FundRaiserBasic.com 
Call 1-800-880-3454, for sales information when you’re ready to upgrade 
Mail: FundRaiser Software 
26A Courthouse Square 
PO Box 901 
West Plains, MO 65775-0901 
USA 
 
Our business hours are from 9am to 5pm Central Time, Monday through 
Friday. We are closed on all federal holidays and on a few other occasions 
for brief vacations during the year.  
 
FundRaiser Website 
This will open your default web browser to the FundRaiser Basic website to 
learn more about the program or to see if there is an updated version.  
www.FundRaiserBasic.com 
 
About 
This will show the FundRaiser Basic version number. 
 
Making Copies of FundRaiser Basic 
Open your FundRasier folder and copy FundRaiser Basic (frbwin.exe), its 
word processor (fred32.exe), and the help files (frbw32.chm) on removable 
media, which you may then pass along to a friend. We encourage you to 
make as many copies as you want. <smile> 
 
Of course, you can also just give them our number: 1-800-880-3454. We’ll be 
glad to send them a free complete evaluation copy. Or, you or your friend 
can download a complete evaluation copy from our web page: 
www.FundRaiserBasic.com 
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 GLOSSARY 
Here are a number of terms which may be unfamiliar to you, and knowledge 
of which will help you as you learn to use FundRaiser Basic. 
 
Account Number 
This is a number assigned by FundRaiser to identify each record. Why not just 
use names? Because people can change their names, and because people 
can have the exact same name. You can just ignore the account numbers, 
(they’re here mostly for the convenience of FundRaiser) and you cannot 
change the account number. 
 
Category Fields  
These are fields on the Codes tab; they may be named anything you like 
and used to record whatever data about your donors that you feel is 
important to have. To change their captions use the Options menu. To 
change the value for the current donor, click on the down arrow to the right 
of the field to choose from a list of existing choices. Click on the pencil-and-
notepad icon to the right of that to update that list. 
 
ComboBox  
Clicking on this pencil icon will popup a “ComboBox” in which you can 
add, delete, and edit entries in the selection list for a field. 
 
Contact Name 
This field is most often used to record the name of your contact person at a 
business, but it can actually be used for any purpose. Important: whatever 
you type in this field will be printed at the top of the address block or mailing 
label. 
 
Country 
This code tells FundRaiser what country name to print in the address block, 
and also how to position the postal code in a manner appropriate for that 
country. It is not necessary to enter a Country Code for an address in your 
own country unless you will be exporting your list to send to someone who 
lives outside your country, and will need to know in what country your 
addresses are located. When printing an address block (as in a mailing 
label) FundRaiser will not print the country name if the Country Code is for 
your own country. To tell FundRaiser what country you live in, click on the 
Options Menu, General Preferences, then on the General tab. 
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Current Order 
This is displayed in the center of the navigation control. As displayed here, 
the current order is by Name. This means that as you navigate through the 
database, you will find that the records are arranged in alphabetical order 
by name. The current order also affects the order when observing names in 
the Browse window. Other orders are by Spouse, Account, Address, and Zip 
Code. To change the order, click on the center bar of the Navigation 
Control, and choose from the available orders in the drop down list. 
 
Database File 
This is a file that can be seen in the Windows Explorer. It contains a set of 
records. FundRaiser has two databases, Master.dbf (which contains the 
donors) and Gifts.dbf. To confuse things somewhat, the Master database is 
actually composed of a pair of files, master.dbf and master.dbt. The dbt file 
contains only the donor notes. 
 
Date Entered 
In the context of the donor, this is the date when you first added this account 
into FundRaiser. It is maintained by FundRaiser and comes from your com-
puter’s internal clock. In the context of a contribution, this is the date when 
you entered the contribution into the computer. It is different from the Date of 
Donation, which is a date that you typed into the computer, and is the date 
that the donor made the donation (often it is a few days before the date 
entered). Note: See Donation Report for important difference between these 
two dates. 
 
Date of Donation 
Also, Date Given. This is the date when the donor made the contribution. It is 
a date that you type into the computer. It is different from the Date of Entry, 
which is the date you were sitting down at the computer. Note: See Donation 
Report for important differentiation. 
 
Donor Name 
This is the name that appears on reports and is the subject of a name search. 
In the case of an Individual type of donor, there are two fields, First and Last. 
If you record middle initial, enter it in First. If you enter suffices (like 
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 FundRaiser Jr or Sr), enter it in Last. A Business name has just one field. 
 
Donor Type 

Individual: a person, family, or household. 
Business: a company, church, civic group, foundation or any other 
organization. 
 

There are two types of donors, Individuals and Businesses. Sometimes a 
donor can be both.  Generally, if the donor gives from his/her personal 
finances, then the type is Individual; if the donor writes you a business check, 
then the donor is a business. If the donor is a church, foundation, civic group, 
or other organization, then the donor still falls within the category of Business, 
which may better be described as a donor that is any organization that is not 
an Individual.  
 
Field 
A field is a single piece of data, like First Name, City, or Date Given. There 
are several fields in a record, and many records in a database file. 
 
HintLine 
Look in the bottom left corner of the Donor Screen for a hint about the field 
you are entering data into. 
 
In-Kind Contributions 
These are gifts of items that cannot be deposited directly into a bank. 
Examples are office supplies, clothing, food, houses, stock, professional 
services. FundRaiser Basic does not differentiate between In-Kind and 
Monetary contributions (our other FundRaiser programs do), so both types 
will appear on financial reports. For a Thank You letter (or receipt), you must 
print an individual letter separate from your other Thank You’s. Be sure to 
describe the donation in sufficient detail to make it clear what was given. 
 
Index files 
These are what keep the data in the database files in the proper 
alphabetical or numerical order. Index files do not contain data; they 
contain pointers to the data in data files. Index files have an extension (file 
type) of NDX. In order to keep these files in healthy condition, it is best to run 
File Maintenance on a regular basis. 
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 LYBUNT 
Donors who gave Last Year But Not This year. This is an important group of 
donors to pursue. They gave to you last year, but have not given since. If you 
don’t act now, they will be lost to you. Because it costs more to obtain a new 
donor than to keep an old donor, it is best to do whatever it takes to keep 
these donors. You find these donors by using the Date of Last Gift criteria in 
the Query Window. See also: SYBUNT. 
 
Mail Merge 
This is computer jargon. It means to merge some data from your donor list 
into a form letter. For example, in your form letter you may have: Dear %
[SALUTATION]: which, when mailmerged, will be printed as: Dear Ms. Smith: %
[ and ] are special markers to tell FundRaiser that this is not normal text, but is 
actually a command to insert data. 
 
Master File 
This file contains all of the data entered in FundRaiser except for the gifts 
(which are recorded in their own database file, Gifts). 
 
Navigation Control 

| First | Previous | {Change Order}| Next | Last | 
 

Clicking on this control enables you to move through the donor list one 
record at a time. These movement commands are also accessible from the 
GoTo Menu. Clicking on the center enables you to change the current order. 
If the current donor record is deleted, the word “Deleted” will appear in red 
in the center of this control. 
 
Prospects 
Donors who have not yet given. Prospects and donors should be mixed in the 
same list. Let FundRaiser keep track of who has given and who hasn’t. 
 
Queue Button 
Click on this button to access the Queue Window, in which you create a 
listing of donors for which you may want to print letters, labels, or envelopes. 
You add donors to the Queue one record at a time. 
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 Query Button 
Click on this button to access the Query Window in which you select donors 
by criteria. Once selected, you will be able to view only the records in this 
group (until you cancel the query). You will also be able to print this group or 
export it. A query can be simple or complex. An example of a simple query 
is “all board members”. A complex query is “all donors from California who 
gave last year but not this year”. 
 
Record 
A record is one distinct set of data contained in a database file. In FundRais-
er, a record is either a gift or a donor. 
 
Reminder Buttons 
Click one of these buttons to store a reminder or note to yourself. When you 
do, the icon will change to display a Blue “i”. 
 
RTF 
RTF stands for Rich Text Format. It is a standard used by most modern word 
processors, including Windows own WordPad, Microsoft Word, and WordPer-
fect, and enables one word processor to read and print a document created 
by another program. FundRaiser uses this standard exclusively. Unfortunately, 
we have found that currently FundRaiser Basic cannot properly print a 
document created in MS Word. 
 
Salutation 
This is the “Dear...” part of a letter - it is how you greet the donor. Some 
organizations prefer a formal greeting (Mr and Mrs Smith); others are much 
more informal (Dick and Jane). Either is correct. 
 
Service Bureau 
This is a business that services your list in some way. Most often, it is to 
prepare a large mailing for you. They will get you the best postal rates, print 
labels, affix them to your mailing pieces, and maybe even do all the printing 
for you. Use FundRaiser’s Export function to copy your data onto a disk to 
give to them. 
 
State 
This is the abbreviation (up to 5 characters, but use only 2 in the USA or 3 in 
Canada) of the State, Territory, or Province. 
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 SYBUNT 
Donors who gave “Some Year But Not This” year. This is an important group of 
donors to pursue. They gave to you once, but have not given recently. 
Because it costs more to obtain a new donor than to keep an old donor, it is 
usually worthwhile to keep trying to re-interest these donors in your cause. 
An annual mailing for 2-3 years after their last gift is usually recommended. 
You find these donors by using the Date of Last Gift criteria in the Query 
Window.  See also: LYBUNT. 
 
Zip/Postal Code 
The postal code of up to 10 characters. If the placement appears to be 
wrong for an address outside of North America, you should still enter the 
code in this field. FundRaiser knows what the proper placement should be for 
all countries, and will adjust it when it prints. 
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 FREQUENTLY ASKED QUESTIONS 
 

Q How do I learn about and get updates to FundRaiser Basic? 
A Updates are issued to fix bugs and to make additions to the program. Mi-
nor updates are issued fairly frequently (every other month or so) and are 
free to all registered users. Major updates (going from Version 2.x to 3.x, for 
instance) are contain significant enhancements, are issued rarely (every 
couple of years or so) and require a small update fee and new registration 
code. For major updates, we contact all users, by mail or email. All minor up-
dates are posted on our website, and may be downloaded and installed at 
your convenience. You’ll also find there a listing of changes to the program, 
so you can see if you want to download that update. If you have given us 
your email address, we will send you a notice whenever an update is re-
leased. To notify us of a change of email address, or to ask not to be sent 
such notices, send an email message to: mail@FundRaiserSoftware com. 
 

Q Can I use FundRaiser Basic both at home and at work? 
A Absolutely. In fact, we’ve made it easy for you to do so. Install FundRaiser 
Basic on both computers. Then, to move the data back and forth, use the 
Create Backup/Restore Backup menu choices in the File Menu. -- Please be 
aware that you cannot enter data or update data in FundRaiser Basic on two 
computers at the same time. This is because when you Restore the Backup 
from one computer to the other, the backup will overwrite any work done on 
that machine. But, read on . . . 
 

Q Can I give a volunteer a copy of FundRaiser Basic to take home to do da-
ta entry?  
A Sure. This is a great way to use volunteer skills. Have them install FundRais-
er Basic on their home computer from the evaluation disk or from the pur-
chase disk set, and enter data. Then have them create a backup to give to 
you. You will import that backup instead of restoring it. This is very important: 
by importing instead of restoring, it adds their list to yours instead of replacing 
your list. Now, one other important point: after your volunteer creates the 
backup to give to you, they must delete the data from their copy of Fund-
Raiser Basic before entering additional names. Otherwise, when they give 
you the next batch, you’ll add those, plus the first batch again, onto your 
computer. To delete the data on the volunteer’s computer, all they need to 
do is to delete three files from the FundRaiser Basic folder (using Windows Ex-
plorer): MASTER.DBF, MASTER.DBT, and GIFTS.DBF. 
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 Q Do I have to buy extra copies of FundRaiser Basic for my home computer 
and for my volunteers? 
A No. As long as you are using them on behalf of the organization that 
bought the software, you may use FundRaiser Basic on as many computers 
as you like. Unlike most software companies, we give you a “site-license”. 
The only thing we ask is that your volunteers call you for technical help. If 
they have a FundRaiser question that you can’t help them with, though, you 
should, of course, drop us an e-mail. 
 
Q What if I outgrow FundRaiser Basic? 
A Quite a few of our Basic users eventually upgrade to either FundRaiser Se-
lect or Professional. We designed the three programs in the FundRaiser  
Family to enable an easy growth path: your data will convert totally in one 
step, and even your financial investment in FundRaiser Basic will transfer, as 
we apply your FundRaiser Basic purchase to any upgrade.  
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 FundRaiser Family 
 
FundRaiser Basic is the baby of our FundRaiser Family of donor management 
programs. If you outgrow FundRaiser Basic, we have others for you to grow 
into. Your data will convert to the new format in one easy step; even the 
money you have paid for FundRaiser Basic will be applied to the purchase 
price of an upgrade. Contact us for a free brochure and evaluation copy.  
Here’s a partial listing of features found in either or all of our other FundRaiser 
Programs, FundRaiser Select, Online, and FundRaiser Pro: 
 
General 

 Households 
 Customizable Password Protection 
 Tag record to automatically exclude from general mailings 
 Spare Fields (unlimited) 
 Unlimited number of Category entries per donor 
 Alternate addresses (vacation or home/office) 
 Relationships between donors 
 Sticky Notes 
 Greatly enhanced query capabilities. 
 Duplicate checking and purging 
 Giving History 
 Type Gift, Membership, Pledge, Tribute (In Memory Of), Other (non-

financial 
 transactions) 
 Mode Check, Cash, Charge, In Kind, etc 
 Purpose Codes 
 Miscellaneous Codes 
 Reporting Period 
 Fund normally tied to a bank account 
 Thank You Letter select which letter to print for this gift 
 Batch Number for entry of multiple batches per day 
 BenefitAmount and Description of any benefit given to donor 
 Premiums any products selected by donor 
 Split Transactions for when a contribution covers multiple purposes 
 Memberships Track expiration dates, dues payments.  
 Print renewal letters, manage reports. 
 Pledges For multi-payment pledges spanning months or years. Print 

reminder letters, overdue letters, management reports. 
 Tributes Record donations made In Memory Of or In Honor Of someone, 

then send letters not only to the donor, but also to the honoree or surviving 
spouse. Print listing suitable for inserting into your newsletter. 
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  Premiums Great for public radio and TV stations who give premiums for 
donations. Prints shipping labels, tracks out of stocks, and more. 

 Tickler System Reminder system can tie todo’s to individual donors and/or 
staff members. 

 Doubles as case history file. 
 Event Log Track donor involvement in or invitations to events, also copies 

of letters sent. 
 Online access for Donors and Staff 
 Can be tied into a project management system. 
 Bulk Mail Print US PostNet barcodes, integrate with USPS National Change 

of Address 
 (NCOA) and CASS Certification system, print bulk mail report. 
 Form Letters and Mail Merging Much, much more capability including the 

ability to change the text of a letter based on different donor conditions. 
 Printing and Reports Batch printing of correspondence. 
 Many management and analysis reports. 
 User definable reports 

 
 
 
 
 

 
 
 

 

 

WHAT OTHERS ARE SAYING ABOUT FUNDRAISER SOFTWARE  

"I also want to tell you how pleased I am with support. Endlessly patient, extremely knowledgeable, 
and able to understand and speak non-techese - I have never encountered a help desk like it.        

Terrific!"  
Glenna R. Polly Klaas Foundation, California  

"We were fortunate to find your software through the internet and found it to contain all the necessary 
tools the more expensive software packages have but at a fraction of the cost."  

Lois L. Center County Youth Service Bureau, Pennsylvania  

"I've been fundraising for 17 years now, and this is the best software I have ever used.                             
It does everything we need, and it's clearly the best value on the market."  

Joe M. Habitat for Humanity of Greater Bucks, Pennsylvania  
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 As of January 2011, pricing (in US$) is as follows: 
 

FundRaiser Select  -- $1200 
    Multi-user (5 concurrent users) -- $1700 
 for modules, add: 

$300 optional Membership module 
$300 optional Tributes module 
$300 optional Pledges module 
$300 optional Product Sales module 
$300 optional Volunteer tracking module 
$200 optional Premiums module 

For the following modules, FundRaiser will provide additional setup and 
support: 

 $500 optional WinTix integration module 
 $500 optional QuickBooks Integration module 
 $500 optional On-Line donations module 

FundRaiser Online -- $395 Setup, $130 per user per month 
FundRaiser Professional -- $3500 base 
    Multi-user (5 concurrent users) -- $4500 base 
 

Client/server versions available for both FundRaiser Select and Professional; 
call your sales representative, or see our website, for details and pricing. 
 
Donor Portal web forms for donations, volunteer sign-ups, memberships and 
more are also available. 
 
No-interest monthly payment plans are available for both FundRaiser Select 
and Professional.   
 
If your organization is part of a larger group, you may be interested to know 
that we also offer multiple-copy discounts for FundRaiser programs.  
 
Call us for more information at 1-800-880-3454, extension 3. 


